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1.  Overview 
 

This manual describes the NOVAC Scanning DOAS system (Scanning Dual-beam miniature 

Differential Optical Absorption Spectroscopy system). The system is designed to measure 

volcanic gas emissions by UV absorption spectroscopy. It is composed of a miniaturized 

spectrometer (Ocean Optics Inc.), an embedded PC, an optical fibre, a telescope, and a GPS-

receiver.  

 

• The optical spectrometer detects ultraviolet light and converts it to digital numbers. 

These numbers are the spectra for later gas evaluation.  

• The telescope collects the ultraviolet light scattered from aerosols and molecules in the 

atmosphere. Controlled by the motor, it is able to turn in 360 degrees. 

• The optical fibre transfers light from the telescope to the spectrometer. 

• The motor controls the angle of the telescope. It moves the telescope certain steps 

according to a command from the embedded PC. 

• The GPS receiver records the position of the system and gives out the universal 

standard time. 

• The embedded PC collects the spectra and manages communication. 

 

Two software packages are needed for the instrument to work. The ‘Kongo’ software runs on 

the embedded PC in the field. It runs the measurements and saves the data to a flash memory 

card in the instrument. The amount of data that the standard flash memory can save depends 

on the number of channels in the spectra and the sampling rate, but typically up to 3 months 

of data can be saved in the embedded PC. When the flash memory is full, the oldest data is 

replaced by new data. 

 

The NOVAC software runs on the computer back at the observatory. It connects to the 

instruments in the field at regular intervals and checks if there is new data to download. If so, 

it downloads the data, deletes it from the instrument’s flash memory, and performs a real-time 

preliminary evaluation of the data, and creates folders where data and results files are 

archived. 

 

The most accurate SO2 emission rate results are obtained by post-processing the data. This is 

also done using the NOVAC software at the observatory. 

 

This manual describes the technical setup of the instruments, the software running on the 

embedded PC and the software running at the observatory. It is updated to describe the 

version 3 (MOXA computer) of the NOVAC instrumentation, but the concepts apply to the 

older instruments as well. For more details on troubleshooting old instrument versions (Beck 

and AXIS computers), see the Appendix. 
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2.  System Requirements 
 

The NOVAC program does not need any other drivers or programs. The platform 

requirements are as follows: 

 

• CPU          -  Pentium III 550 MHz or higher 

• Memory        -  64 MB or more 

• Operating System   -  Windows 

• Screen Resolution  -  1024 by 768 pixels or higher. 
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3.  Setup and configuration of the instruments in 

the field 

3.1 Technical setup 
 

The NOVAC scanning DOAS instruments should be installed at a location on the volcano 

where the plume is expected to be overhead. It is recommended to install at least 2 

instruments within a few km of one another (on the same side of the volcano) such that the 

plume height can be triangulated when the plume is overhead.  

 

The instrument runs off 12V power. The power consumption is approximately 8W while on. 

If run for 8 hours per day, the power daily average power consumption is approximately 3W. 

This does not include the power consumption of the telemetry. A FreeWave HT-PE radio is 

often used for telemetry. This option uses another approx. 3W while on. An appropriate solar 

power system or line power should be used to power the instrument and telemetry. In the 

following, the NOVAC instrument itself is described. 

 

3.1.1 Spectrometer and measurement electronics 

The current version (3) of the NOVAC instrument consists of 3 main parts: The Ocean Optics 

SD2000 spectrometer, the MOXA UC-7112 embedded PC, and a custom electronics box built 

by Manne Kihlman (sometimes called ‘Octopus’ for obvious reasons). 

 

 

Figure 1- Picture of the NOVAC instrument. The main components are the Ocean Optics SD2000 

spectrometer, the MOXA UC-7112 embedded PC, and the custom ‘Octopus’ electronics. Other optional 

components shown are a Theben TR610top2 timer, a FreeWave HT-PE radio modem, a ControlByWeb 

Ethernet relay, and a Stride SE-SW5U Ethernet switch. 
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Though the MOXA is the brain of the instrument, the Octopus is the center of most wiring 

connections so it’s usually easiest to use this element as the starting point for connections. 

The following wiring diagram and photographs show how to connect the various components 

to one another. Remember that the optical fiber is very fragile and may not be bent more 

than about a 15 cm radius! Be very careful when connecting the fiber. 

 

Custom 
Electronics 
‘Octopus’

MOXA
UC-7112

Embedded PC

Ocean Optics
SD2000 or

S2000 Spectrometer

GPS

Timer
Theben
TR 610 
top2 

+12V

GND

+12V

GND

P1

P2

Scanner /
Stepper Motor

DB9 Dongle

Ethernet 
Switch or 

Radio Modem

LAN1

Power cable

Ribbon cable

Ethernet cable

DB9 adapter

Motor cable
Unconnected
DB9 cable

A

B

C

D

E

F
G

H I

J

K

Ethernet cable

Optical fiber

Wiring diagram
NOVAC version 3 (MOXA) instrument

 

Figure 2 – Wiring diagram for the NOVAC version 3 (MOXA) instrument. The circled letters correspond 

to the following photographs of respective connectors and components. 

 

 

 

Figure 3 – (A) Power connector supplying 12 V to custom electronics ‘Octopus’ 
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Figure 4 – (B) The Octopus supplies the MOXA embedded PC with power 

 

 

Figure 5 – (C) PS2 connection from the Octopus to the GPS 

 

 

Figure 6 – (D) There are 2 types of GPS units currently in use. Both have PS2 connectors. 
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Figure 7 – (E) The Octopus supplies the Spectrometer with power through a 2 lead ribbon cable. 

 

 

Figure 8 – (F) One DB9 cable on the Octopus has a dongle on it enclosing a temperature sensor. Don’t 

remove the dongle. 

 

 

Figure 9 – (G) The Octopus has two identical male DB9 connectors protruding from it. These can be used 

to power stepper motors. The current NOVAC system (v. 3) only uses 1 motor. The correct DB9 connector 

must be identified by trial and error. Connect the motor cable to one of them and see if the motor works. 

If not, try the other connector. 
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Figure 10 – (H) The motor connector is DB9. This adapter is required to connect the motor cable. 

 

 

Figure 11 – (I) The motor cable is long enough to reach the scanner (typically on a pole). 

 

 

Figure 12 – (J) One ribbon cable coming off the Octopus is split into 2 female DB9 connectors, with an 

additional 3-lead ribbon cable splitting off and going to a male DB9 plug. The two female connectors go 

into serial ports P1 and P2 on the MOXA. The plug with the extra cable coming off it goes in P1. 

 



   NOVAC Scanning DOAS Manual 

 

 10 

 

Figure 13 – (K) The extra 3-lead cable coming off the MOXA P1 plug goes to the spectrometer. It only fits 

in the one serial port. 

 

3.1.2 DOAS Scanner 

 

The NOVAC DOAS scanner is used to scan the sky from horizon to horizon, scanning a 

cross-section of the volcanic plume if it is overhead. The scanner is assembled from a number 

of individual components.  

 

Coming from the spectrometer, one or two optical fibers end in the focal plane of a simple 

telescope. The telescope contains an optical bandpass filter that only transmits UV 

wavelengths, filtering out visible and infrared radiation (very little visible light is let through, 

so it’s not possible to look through the telescope). A quartz lens defines a relatively narrow 

field of view of about 0.6 (11 mrad), which can be approximated as a single beam. 

 

The telescope is pointed at a scanning element. This is either a mirror or a prism, depending 

on whether the scanner is a ‘cone’ or ‘flat’ scanner. A flat scanner has a 90-degree scan angle 

and scans from one horizon to the other passing through the zenith. Flat scanners use a prism 

to deflect the light into the telescope. Cone scanners have a 60-degree scan angle and 

therefore surround the volcano a bit during the scan. They never pass through zenith, but 

rather define a cone around the volcano. The cone scanners use a mirror to deflect light into 

the telescope. There are also two types of scanner hoods, and the correct one needs to be 

employed for each type of scanner (see images below). The hood rotates together with the 

mirror or prism; thus light is transmitted through a quartz window in the hood that is always 

aligned with the internal mirror (prism). 

 

If the plume is located overhead, wind measurements can be made by using a ‘dual-beam’ 

scanner. (Though this mode of operation is currently not functional in the instrument 

version 3 (MOXA), we hope to restore this functionality soon). Dual-beam scanners use 

two fibers leading to an SD2000 double spectrometer. During normal scanning operation, 

only one spectrometer channel (typically the Master channel) is used; if the conditions are 

right for a wind measurement, the second spectrometer channel (Slave) is also used. The main 

difference between single and dual beam scanners is that the instrument uses two fiber optics 

cables, and therefore the telescope has two holes that accept the fiber ends (see pictures 

below). Dual-beam scanners are by default flat. 
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When the instrument is powered on, the computer does not know in which direction the 

scanner is pointing. Therefore, the first thing that the scanner does is find its ‘home’ position. 

This position is defined by a small reference switch inside the scanner. When the scanner is 

powered off, it can be rotated by hand. You should be able to hear a little ‘click’ when the 

scanner passes through the reference switch. Once this switch is reached, the computer knows 

the scanner is at ‘home’ and the measurements can begin. In the past, the reference switch has 

sometimes come loose. If this happens, the instrument will no longer be able to find ‘home’, 

and no measurements will be made. Check to ensure that the reference switch is activated 

properly. If not, the scanner hood should be removed, the four screws holding the stepper 

motor plate taken out and the switch adjusted as close as possible to the motor axis to ensure 

proper contact with the motor switch. 

 

When installing the scanners in the field, the axis of the scanner is typically lined up with the 

volcanic vent. The scanner hood should be pointing away from the volcano. The mirror in the 

cone scanners will collect light coming from the direction of the volcano only if the scanner is 

pointing away from the volcano. In the standard configuration of the scanner, the rotation 

proceeds clockwise as seen from the scanner hood in direction of the volcano. 

 

 

Figure 14 – NOVAC scanner assembly. This is a ‘cone’ scanner. Note how the cone scanner points back 

towards the right in this image. This would be the proper mounting direction if the volcano is on the right 

side of the image. This positioning also holds for flat scanners. 

 

 

Figure 15 – The optical elements in the NOVAC scanner. A telescope is pointing at a moving mirror. The 

mirror is mounted on a stepper motor. The motor shaft protrudes out the far side as well – this is where 
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the scanner hood is mounted. On both sides of the motor shaft there are flattened sections in opposite 

positions. These indicates where the screws of the hood (external shaft) and the mirror or prism (internal 

shaft) have to be fastened. 

 

 

Figure 16 – The double scanner (on the left) has two holes for fiber optic cables to be connected and 

secured with corresponding screws (one of which is visible on the left scanner). The single scanner (on the 

right) has only one fiber connection and screw. The other holes on the plate are intended for securing it 

with a special tool. 

 

 

Figure 17 – When switching from a cone to a flat scanner, the mirror must be replaced by a prism and the 

cone scanner hood must be replaced by a flat hood like the one in this image. Flat scanners are preferable 

for dual-beam instruments. 

 

 

3.1.3 Example setup 

 

To ensure a good view of the volcanic plume and the horizon on either side of it, the NOVAC 

scanners are typically mounted on a pole of some sort, thus lifting it above any local 

obstructions such as vegetation or buildings. The rest of the NOVAC instrument will perform 

best if it’s not exposed to the elements (heat, precipitation, volcanic gas) more than necessary. 

Therefore, the instruments are typically placed in a separate box located at the base of the 

pole, possible shaded by the solar panels. The fiber optics and motor cable are then run 
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through the inside of the pole down to the instrument. The telemetry antenna can be mounted 

on the same pole as the scanner if it does not obstruct the instrument’s view of the sky. 

 

 

Figure 18 – Test setup of a NOVAC instrument in the parking lot of the Cascades Volcano Observatory. 

The scanner is mounted on a pole (it would normally be mounted higher to ensure clear view of the sky), 

and the instrument is in the metal box under the solar panels. 

 

 

Figure 19 – Recently, the FreeWave HT-PE radio modems have been shown to work very well with the 

NOVAC instruments. These radios offer two Ethernet and two serial ports, so additional instrumentation 
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such as a seismometer or webcam can be collocated with the NOVAC scanning DOAS and telemetered 

over the same radio. 

3.2 Configuring the instrument in the field 
 

The ‘cfg.txt’ is located on the embedded PC. This file defines how the measurements by the 

instrument should be done. The cfg.txt file is read by the data collection software kongo.exe. 

There is no difference in the formatting of the cfg.txt file between the different instrument 

versions (Beck, Axis or MOXA). However, there are some differences in the file locations as 

well as methods for accessing the file. Here, we will describe the most current version 

(MOXA computer). For a description of the older instrument version, see the appendix of this 

manual. 

 

3.2.1 Give your computer a static IP address 

To establish a connection to the MOXA, the computer you are using needs to be set to a fixed 

IP address. In Windows 7, this is done in the ‘Network and Sharing Center’ by clicking on 

‘Change adapter settings’ in the top left. 

 

 
 

After clicking ‘Change adapter settings’, right-click on the Local Area Connection and select 

‘Properties’. 
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Click on ‘Internet Protocol Version 4 (TCP/IPv4)’ and select ‘Properties’. 

 

 
 

Now select ‘Use the following IP address’ and enter an IP address that is on the same Subnet 

mask as the instrument. Do not use the IP address of the instrument! Note that the MOXA 

computer should always be accessible at IP address 10.0.0.90, subnet 255.255.0.0 on LAN2. 

These LAN2 settings should never be changed. If you are connecting to the MOXA via the 

LAN2 port, you might set your laptop to the IP address 10.0.0.91 and the Subnet 255.255.0.0 
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Click OK. You have now finished configuring your computer. 

 

3.2.2 Connecting to the instrument using FileZilla 

FileZilla is a free ftp client that can be used to access the files on the MOXA embedded PC. 

The software is available for download at https://filezilla-project.org/. 

 

Plug a network cable into the MOXA computer and connect your laptop (alternatively, this 

procedure can be performed over an existing telemetry link). 

 

After starting the FileZilla software, check the top left of the screen. There should be a field 

for the Host, Username and Password.  

 

 
 

In the ‘Host’ field, type the IP address of the MOXA. If you are connected to the LAN2 port 

on the MOXA, the IP address should be 10.0.0.90. The Username is novac, and the password 

is 1225. Click ‘Quickconnect’. 

 

If the connection is successful, a directory listing will appear on the right side of the screen. 

This is the directory structure of the MOXA embedded PC. 

 

3.2.3 Configuring the network settings (IP address) of the MOXA 

The network settings for the MOXA embedded PC are saved in the file 

\etc\network\interfaces. To configure the network settings of your instrument, download this 

file by double-clicking on it in FileZilla. It will now be downloaded to the laptop computer to 

the directory that is currently displayed on the left half of the screen in FileZilla. 

https://filezilla-project.org/
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Close FileZilla before continuing. We have found that leaving FileZilla open while editing the 

interfaces file can lead to unexpected results. 

 

Next, open the interfaces file with a text editor. It should look something like this: 

_________________________________________________________________________ 

 

############################################################

########## 

# /etc/network/interfaces -- configuration file for ifup(8), ifdown(8) 

# 

# A "#" character in the very first column makes the rest of the line 

# be ignored. Blank lines are ignored. Lines may be indented freely. 

# A "\" character at the very end of the line indicates the next line 

# should be treated as a continuation of the current one. 

# 

# The "pre-up", "up", "down" and "post-down" options are valid for all  

# interfaces, and may be specified multiple times. All other options 

# may only be specified once. 

# 

# See the interfaces(5) manpage for information on what options are  

# available. 

############################################################

########## 

 

# We always want the loopback interface. 

 

auto eth0 eth1 lo 

iface lo inet loopback 

 

# embedded ethernet LAN1 

iface eth0 inet static 

 address 192.168.1.2 

 network 192.168.1.0 

 netmask 255.255.255.0 

 

# embedded ethernet LAN2 

iface eth1 inet static 

 address 10.0.0.90 

 network 10.0.0.0 

 netmask 255.255.255.0 
 

This may be followed by a number of examples. But the two blocks that begin with iface eth0 

intet static and iface eth1 inet static are where the two LAN ports can be configured. It is our 

strategy to never change the LAN2 settings. They should always be kept at IP 10.0.0.90 

and Subnet 255.255.0.0. This way we ensure that whenever we go to a NOVAC 
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instrument in the field, we will always be able to log in on LAN2. The settings for LAN1 

can be changed to whatever settings are needed for the telemetry network at a given volcano. 

However, always make sure that LAN1 and LAN2 are on different subnets. This means 

that the third number in the IP address must be different. Setting both Ethernet ports to 

the same subnet may give unexpected results. 

 

Once the interfaces file has been modified, upload it to the \etc\network\ directory on the 

MOXA using the same technique as before. Replace the existing interfaces file. Reboot the 

MOXA for the changes to take effect. 

 

In order to avoid problems, it is recommended that you keep a backup of the original 

working interfaces file somewhere on your computer. 

 

 

 

 

3.2.4 Configuring the scanner measurement routine (cfg.txt) 

 

The instrument measurement routine tells the scanner where to measure and for how long. 

This routine is defined in a text file called cfg.txt located in the /mnt/flash directory on the 

MOXA computer. The cfg.txt file is read by the kongo.exe software each time the instrument 

is powered on. 

 

Below is a copy of an example cfg.txt file. There are two section of the cfg.txt file. In the first 

part of the file, several settings are specified. These will be described in more detail below. 

The general syntax is SETTING=###, where ### is a numerical value. The meaning of the 

individual settings will be described in this section. A line that begins with a ‘%’ is a 

comment and is not read by the kongo.exe software. The settings given below can be used as 

a default when configuring a new NOVAC scanner. 

 

In the second part of the cfg.txt file, the angles at which the scanner should take 

measurements are defined. Each entry that begins with MEAS=… represents one position of 

the scanner at which a measurement will be performed. Details are discussed below. 

 

% This is the cfg.txt file 

% The settings given below can be used as a default when configuring a new scanner 

 

% The following channels defines which channels in the spectra that will be transferred 

% This should normally be all pixels on the detector (0 -> 2047) 

STARTCHN=0 

STOPCHN=2047 

 

% If Realtime=1 then the spectra will be added to work.pak one at a time. 

% If RealTime=0 then the spectra will be added to work.pak one scan at a time 

REALTIME=0 

 

% The Cone-Angle of the system (half the opening angle of the cone) 

%  Should be 90 if this is a flat instrument and 60 if this is a conical 

CONEANGLE=60 
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% The geometry: compassDirection  tiltX(=roll)  tiltY(=pitch)  temperature 

COMPASS=100.4 0.0 0.0 

 

% StepsPerRound defines the number of steps the steppermotor divides one round into 

STEPSPERROUND=200 

 

MOTORSTEPSCOMP=119 

DELAY=500 

POWERSAVE=0 

 

%If Skipmotor=1 then the scanner will not be used. ONLY FOR TESTING PURPOSES 

SKIPMOTOR=0 

 

% The computer will shut down all activity if the voltage of the battery is below this limit 

BATTERYLIMIT=10 

 

% Percent defines how big part of the spectrometers dynamic range we want to use 

PERCENT=0.7 

 

% Channel is the pixel around which the intensity of the spectra will be measured  

%  a value of -1 means the maximum value in the spectrum 

CHANNEL=-1 

 

% The maximum integration time that we allow the spectrometer to use. In milli seconds 

MAXINTTIME=1000 

 

% The debug-level, the higher number the more output will be created 

DEBUG=1 

 

% sum1 is inside the specrometer [1 to 15] 

%-----pos----time-sum1-sum2--chn--basename----- repetitions--flag 

MEAS=0 -1 15 1 0 sky 1 0 

MEAS=100 0 15 1 0 dark 1 0 

MEAS=-50 0 15 1 0 scan 1 0 

MEAS=-48 0 15 1 0 scan 1 0 

MEAS=-46 0 15 1 0 scan 1 0 

MEAS=-44 0 15 1 0 scan 1 0 

MEAS=-42 0 15 1 0 scan 1 0 

MEAS=-40 0 15 1 0 scan 1 0 

MEAS=-38 0 15 1 0 scan 1 0 

MEAS=-36 0 15 1 0 scan 1 0 

MEAS=-34 0 15 1 0 scan 1 0 

MEAS=-32 0 15 1 0 scan 1 0 

MEAS=-30 0 15 1 0 scan 1 0 

MEAS=-28 0 15 1 0 scan 1 0 

MEAS=-26 0 15 1 0 scan 1 0 

MEAS=-24 0 15 1 0 scan 1 0 

MEAS=-22 0 15 1 0 scan 1 0 

MEAS=-20 0 15 1 0 scan 1 0 

MEAS=-18 0 15 1 0 scan 1 0 

MEAS=-16 0 15 1 0 scan 1 0 

MEAS=-14 0 15 1 0 scan 1 0 

MEAS=-12 0 15 1 0 scan 1 0 
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MEAS=-10 0 15 1 0 scan 1 0 

MEAS=-8 0 15 1 0 scan 1 0 

MEAS=-6 0 15 1 0 scan 1 0 

MEAS=-4 0 15 1 0 scan 1 0 

MEAS=-2 0 15 1 0 scan 1 0 

MEAS=0 0 15 1 0 scan 1 0 

MEAS=2 0 15 1 0 scan 1 0 

MEAS=4 0 15 1 0 scan 1 0 

MEAS=6 0 15 1 0 scan 1 0 

MEAS=8 0 15 1 0 scan 1 0 

MEAS=10 0 15 1 0 scan 1 0 

MEAS=12 0 15 1 0 scan 1 0 

MEAS=14 0 15 1 0 scan 1 0 

MEAS=16 0 15 1 0 scan 1 0 

MEAS=18 0 15 1 0 scan 1 0 

MEAS=20 0 15 1 0 scan 1 0 

MEAS=22 0 15 1 0 scan 1 0 

MEAS=24 0 15 1 0 scan 1 0 

MEAS=26 0 15 1 0 scan 1 0 

MEAS=28 0 15 1 0 scan 1 0 

MEAS=30 0 15 1 0 scan 1 0 

MEAS=32 0 15 1 0 scan 1 0 

MEAS=34 0 15 1 0 scan 1 0 

MEAS=36 0 15 1 0 scan 1 0 

MEAS=38 0 15 1 0 scan 1 0 

MEAS=40 0 15 1 0 scan 1 0 

MEAS=42 0 15 1 0 scan 1 0 

MEAS=44 0 15 1 0 scan 1 0 

MEAS=46 0 15 1 0 scan 1 0 

MEAS=48 0 15 1 0 scan 1 0 

MEAS=50 0 15 1 0 scan 1 0 
________________________________________________________________________________ 
 

 

Here follows a description of all the fields in the cfg.txt file. 

 

STARTCHN= and STOPCHN= 

This determines the start channel and stop channel of the spectrum polled from the 

spectrometer. If both values are zero or if these parameters are not given, then all the channels 

of the spectrum are used. 

Default:  

 

REALTIME= 

This setting determines how spectra are saved and transmitted to the observatory. Use 

REALTIME=0 for version 3 (MOXA) instruments. 

 

CONEANGLE= 

Defines the cone-angle of the instrument. This can either be 60 (cone scanner) or 90 (flat 

scanner). This value is written in the header of each spectrum (version 4 and newer). It is 

very important to use the correct value here, or the evaluation will give incorrect results! 

 

COMPASS= 
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This parameter takes 3 numbers separated by spaces. The first number is the compass 

direction of the scanner. Normally, this is the direction from the instrument to the volcano. 

E.g. if the volcano is west of the instrument, the compass direction would be 270.0. An 

instrument installed on the north side of a volcano would typically have a compass direction 

of 180.0, since the direction from instrument to volcano is south. Note that when the scanner 

is mounted on the pole, it protrudes away from the volcano, not towards it. However, the 

compass direction is towards the volcano. 

Currently, the second and 3rd numbers in this line are not used and should be set to 0.0. 

Therefore, the correct entry for an instrument installed on the east side of a volcano would be 

COMPASS=270.0 0.0 0.0 

This setting must be correctly configured when installing a new instrument! 

 

STEPSPERROUND= 

This gives the number of steps required to make one full turn of the scanning system. For the 

stepper motors we currently use, the value is 200. Very few NOVAC instruments were built 

with more than 1 motor. If you are using a ‘Heidelberg’ type instrument with 2 motors, this 

string should have two numbers separated by a space. But in most cases, it should be set to 

STEPSPERROUND=200 

 

MOTORSTEPSCOMP= 

This is the number of steps between the location of the scanner reference switch and the 

position at which the scanner is looking straight up at the zenith position. Usually it is about 

120. This parameter is best set by watching what the scanner does when the instrument power 

is turned on. When the power comes on, the scanner will first go to the reference switch 

location. Then, it should go straight up. If it doesn’t go straight up, modify the 

MOTORSTEPSCOMP and try again until it does go straight up. In the usual way that the 

rotation is implemented, this number should be increased if the motor stops ahead of the 

zenith position and decreased if it stops behind.  If two motors are used (Heidelberg type 

instrument) then also two values must follow this string. This is rare. 

 

DELAY= 

This determines how many milliseconds to pause between each pulse when pulsing the 

stepper-motor. If this is set to 0 then the fastest possible speed will be used. Recommended 

values are 200 for the flat scanners and 500 for the cone scanners. 

 

POWERSAVE= 

In the current MOXA version of the instrument, this setting should be set to 0. 

 

SKIPMOTOR= 

If this value is not zero, then all motor-activity is skipped. This should only be used for 

testing! 

 

BATTERYLIMIT= 

This setting tells the instrument when to shut off if the battery voltage gets too low. Typically, 

we use 10, which means the instrument shuts off if the battery voltage goes below 10V. 

 

PERCENT= 

A decimal number between 0 and 1 should follow this string. This entry determines the 

desired relative saturation of a spectrum recorded using an automatic exposure time. It should 
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normally be about 0.7, which means the exposure time will be chosen such that the spectral 

intensity is 70% of the saturation value. 

 

CHANNEL= 

This determines the channel where the max-value used for the automatic exposure is 

determined. The light intensity will be averaged over 10 pixels centered on the channel given 

by this argument. If CHANNEL=-1 or if it is not defined, then the max-value over all pixels 

will be used to determine automatic exposure time. 

 

MAXINTTIME= 

This is the maximum integration time that the spectrometer is allowed to use, in ms. Usually 

set to 1000. 

 

DEBUG= 

The higher value given here, the more status messages will Kongo.exe produce for debugging 

purposes. If DEBUG=0 then no text is written. Usually DEBUG=1 is a good value. 

 

SERVER= 

Only used if the instrument is connected directly to the internet. This determines the FTP 

server that will be contacted when the IP number of the embedded computer changes. For 

example, if “SERVER= 192.168.1.20 novac 1225” is written in cfg.txt file, the remote PC 

will contact an FTP server with IP address 192.168.1.20 username novac and password 1225. 

When IP address is changed, the embedded computer will try to upload a file to this FTP 

server with the name given by the INSTRUMENTNAME= parameter. If SERVER= is not 

given at all or if the IP nr=0.0.0.0 then no attempt to connect is made. 

 

FTPTIMEOUT= 

This determines the timeout in milliseconds for accessing the server given by the SEVER= 

parameter. 

 

MEAS= 

This determines the different measurement position that should be used. 

Typically, many MEAS= lines are following each other with increasing position in the end of 

the cfg.txt see the example in the beginning of this chapter. 

Note: STEPSPERROUND= should always be define before the first MEAS= line. 

 

• pos1, pos 2 – Position in motor steps. The reference position is zenith position. 

If only one motor is used, then only one parameter indicating the motor position is 

expected.  

 

One row of measurement position definition looks like this: 

 
MEAS= pos1 exptime sum1  sum2  chn  basename  repetitions  flag 
 
MEAS= 0 -1 1 1 0 up_ang   1 0 
 

If two motors are used, then two parameters indicating the two motor-positions are 

expected (pos1 and pos2): 

 
MEAS= pos1  pos2  exptime  sum1  sum2   chn  basename  repetitions  flag 
MEAS= 0  0     -1    1     1   0      up_ang 1 0 
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• exptime – Exposure time in milliseconds. It has three kinds of values. 

Positive – Use this value as the exposure time for the spectra collection at this 

position 

0 –  Use same exposure time as the first MEAS= line 

Negative - an automatic exposure time is calculated for the spectra collection 

at this position. 

The first MEAS= line is used for the zenith measurement and using automatic 

exposure time.  

 

• sum1 - the number of spectrums added together inside the spectrometer. This number 

is limited to a value between 1 and 15. 

• sum2 - the number of spectrums added together in the embedded computer. This 

number is limited to a value between 1 and 32767. The total number of added 

spectrums are sum1*sum2. It is better to use a high sum1 instead of a high sum2 since 

it reduces the time for transfer spectrum from the spectrometer. 

• chn - the channel number for the spectrometer. When a double-spectrometer is used 

then chn=0 will use the master-channel and chn=1 will use the slave channel. Values 

above 256 have special meaning, see the documentation for the OceanOptics 

spectrometers. With a single spectrometer chn=0 should be used. 

• basename - gives the name of this direction. This is copied into the header of the 

spectrum file. 

• repetitions - determine how many times this MEAS= line will be repeated. 

If this value is 0 then it will not be executed at all. This is useful when doing wind-

measurements, where the system should stand for a long time taking many spectrums in 

the same direction. If the repetitions number is missing in the MEAS= line then 

repetitions will be set to 1.  For fixed angle measurements, set repetition between 25 and 

49.  The NOVAC Program software will interpret fixed angle measurements with 

repetitions greater than 50 to be wind measurements. 

• flag – it is used for new scanner. It determines the state of the solenoids.  

 

3.3 Troubleshooting the instrument with PuTTY, Telnet, or 
Hyperterminal 
 

3.3.1 Connecting to the MOXA with a Telnet client 

If the instrument has been configured but still appears to not be running properly, then it may 

become necessary to check what exactly is going wrong. For this, it is useful to log in to the 

MOXA electronics using a telnet client. Newer versions of Windows may not have Telnet, 

but PuTTY is a freely available software that can be downloaded here: 

 

www.putty.org 

 

To connect to the MOXA, first give your computer a static IP address on the same Subnet as 

the MOXA as described earlier in this chapter. Next, connect your computer to the MOXA 

using an Ethernet cable. When PuTTY is started, you will see the below window: 

 

http://www.putty.org/
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Type in the MOXA IP address in the ‘Host Name’ field (default 10.0.0.90 for LAN2 port) and 

set the ‘Port’ to 23. Select ‘Telnet’ for the ‘Connection Type’. Click ‘Open’. You will be 

prompted for a username and password. All NOVAC instruments have the user novac and the 

password 1225. 

 

You should now be connected to the MOXA computer, where the Kongo.exe program should 

be running. 

 

3.3.2 Useful commands for troubleshooting 

 

To show the output of the Kongo – program the commands showlog and nolog are used. 

Typing them in at the command prompt and pressing Enter should have the following effect: 

 

showlog: giving this command will make the remote PC show the output from the kongo 

program for some minutes. These messages can be quite helpful for troubleshooting the 

instrument. For example, if you see the message ‘Spectrometer refuses to scan’, you might 

check to make sure that the spectrometer is properly connected and has power. It is still 

possible to type commands while the kongo output is being displayed. If no messages are 

displayed after giving the command showlog, the remote PC might have stopped working. 

Then one solution is to reboot the remote PC. 

 

nolog:  giving this command will stop showing the output from the kongo program. 

 

You can browse the directory structure of the MOXA and view text files using the following 

Linux commands: 

 

ls 

Shows the files and directories in the current directory.  
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ls -l 

A more extensive list, including file sizes and access rights can be obtained by adding the flag 

‘-l’. 

 

more 

This built-in program can be used to view the content of a file. E.g. if you want to read the 

content of the file cfg.txt the command to use is the following (if cfg.txt can be found in the 

current directory): more cfg.txt 

 

rm 

This command removes a file found in the current directory. E.g. rm U001.pak 

 

reboot 

Reboots the remote PC. 

 

cd 

Change the current working directory. This can be an absolute path or a relative path. E.g. 

changing to the data-storage directory: cd /mnt/flash/novac/ 

Changing to the parent directory of the current working directory by the command (notice the 

space): cd .. 

 

3.3.3. Description of important files and their locations 

 

cfg.txt is the configuration file that tells the NOVAC scanner in which directions to measure 

and for how long. Details of this file are discussed in the previous section ‘Configuring the 

instrument in the field’. The ‘cfg.txt’ file is in /mnt/flash/. 

 

Kongo is the program which controls the whole Scanning DOAS. It downloads data from the 

spectrometer and creates the file upload.pak upon the completion of one full scan. The kongo 

software is in /home/ 

 

Upload.pak is a compressed spectra file which is ready to be transferred to our local 

computer. These data files are stored in /mnt/flash/novac/ 

 

U001.pak, U002.pak, … these are compressed spectrum files ready to be transferred to our 

local computer. These are also stored in /mnt/flash/novac/ 

 

3.3.4. Connecting the Moxa with a serial cable 

The Moxa computer can also be accessed with a serial connection (RS-232). This is an option 

when the Ethernet connection fails, if serial radio modems are used for telemetry or if the 

LAN settings need to be modified or accessed. If a serial connection is attempted, no other 

cable should be simultaneously connected to the Ethernet ports. 

 

For this type of connections, it is necessary to connect with the black serial console cable 

provided with the instrument, shown below: 
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Figure 20. Serial console cable of the Moxa computer. The left figure shows the pin distribution of the 

cable. 

 

An easy way to communicate is via the HyperTerminal program. First the computer used to 

communicate with the Moxa must have an available COM port (typically provided with older 

computers, newer computers can use a COM port emulator instead, for example a USB-to-

serial adaptor that creates a virtual COM port). Then open HyperTerminal and configure the 

available port in your computer according to these settings:  

 

 

Figure 21. Settings for HyperTerminal communication 

 

Then a session opens up and you could type the commands listed in section ‘3.3.2 Useful 

commands for troubleshooting’. There is no need to provide credentials for login in this case. 

 

For previous versions of the computer check the The measurement configuration for each 

instrument is stored in the file cfg.txt on the embedded computer. This file has a very specific 

format which is described in section 3.2.4 of this manual. If the file format is compromised in 

some way, the instrument may not be able to recognize the cfg.txt file as a configuration file, 

and a default configuration will be assumed. 
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Unfortunately, this default configuration will generally not be useful. Upon reboot, the 

scanner will move to the end position, then rotate to a fixed direction and measure a single 

spectrum called 'scan'. This single acquisition will be repeated, each time starting a new *.pak 

file on the SD card. In other words, each saved *.pak file will only contain a single 'scan' 

spectrum. 

 

Also, the DELAY parameter will default to 0, which may make the scanner spin at a very 

high speed, or since the delay is meant to ensure proper stepping of the motor, it may mean 

that the scanner does not move at all. If the scanner is spinning very quickly despite the 

fact that the user has set the DELAY parameter to a reasonable value (e.g. 500), then 

there is likely a problem with the formatting of the cfg.txt file. 

 

One common yet very subtle problem with the cfg.txt file formatting is improper use of 

'end of line' characters. If the wrong end of line characters are used, the text file may 

seem completely fine when opened in a text editor on a computer, but may still not be 

recognized by the computer embedded in the NOVAC instrument.  

 

The embedded computer will recognize the cfg.txt file if each line of the text file ends with 

both a 'carriage return' (CR) and 'line feed' (LF) character. The text file may not work if only 

one of these characters is present. The way to check this is to open the cfg.txt file in a text 

editor and make the special characters visible. One editor capable of this is the freely 

available Notepad++. In this software, clicking on the 'Show All Characters' button in the 

quick access bar at the top will make special characters visible. The end of line convention 

can then be set using the menu. Selecting Edit -> EOL Conversion -> Windows will ensure 

that each line ends in CR LF. After reformatting the text file, overwrite the existing cfg.txt on 

the embedded computer. Hopefully, the instrument will now recognize the configuration. 

  
Appendix A: Previous versions of the NOVAC instrument. 
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4.  Configuring the NOVAC software at the 

observatory 
 

The most stable present version of the NovacProgram is v3.1. To know which version of the 

program you are running, click on ‘Help->About Novac Program…’ in the main window of 

the software. 

 

You can just copy NovacProgram.exe and configuration.xml into any folder in the computer 

(the 2 files must be copied to the same directory).  The program is then ready to run. If you do 

not have a configuration file, just copy the NOVAC program and create a configuration 

through the configuration dialog as described below. 

 

Before the NovacProgram can download and evaluate spectra from connected instruments, it 

is necessary that the configuration is correct. The configuration is stored in the file 

‘configuration.xml’ in the same directory as the NovacProgram and is modified through the 

configuration dialog inside the NovacProgram. This is reached from the main menu in the 

main-window of the program. Choose ‘Configuration’→’Configuration’ to open the 

configuration dialog. 

 

To close the configuration dialog press either of the two buttons ‘Save’ or ‘Cancel’ in the 

lower right of the dialog. Pressing ‘Save’ will save all changes made, pressing ‘cancel’ will 

discard all changes made in the dialog. Note that the NovacProgram will have to be restarted 

for changes to come into effect. 

 

4.1. Scanning Instrument Settings 
The settings found under the ‘Scanning instrument’ – tab are individual settings for each of 

the connected scanning instruments in the local network.  

 

In the Scanning Instrument list to the left in the configuration dialog (see Figure 22) choose 

one instrument. The configurations will be special for that instrument. 

 

If the list of scanning instruments is empty, press the button ‘Add’ below the list (see Figure 

22) to insert one more instrument into the list. More instruments can be added to the list by 

again pressing the button ‘Add’. 

4.1.1 Instrument information ‘Info’ 

 

Under the ‘Info’ tab are the general settings about the scanning instrument, which are 

necessary to handle the data coming from the instrument (see Figure 22). 

 

In the Site group, you can set the name of the volcano (choose one from the list), the name of 

the site where the instrument is located, and the name of the observatory performing the 

measurements. All fields must be filled in for the program to function properly.  If your 

volcano is not listed, select ‘Other’ and you will be prompted for the source name and 

coordinates. 
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In the Spectrometer group, there are settings that give general information about the 

spectrometer used.  Select the model of the spectrometer used.  If the spectrometer is not 

listed, select the ‘Custom…’ option and manually add the spectrometer name and maximum 

intensity.  The serial number is the serial number of the spectrometer, as given by the supplier 

of spectrometers. This identifies the spectrometer and is necessary for performing evaluations 

of the spectra. If the spectrometer contains several channels, it is necessary to select the 

number of channels from the drop-down list for the program to be able to handle all spectra. 

Note it is important that the configuration contain the serial number of all spectrometers used 

in the local network. Any data coming in from a non-configured spectrometer will not be 

handled correctly and the data will not be shown in the interface. 

 

In the Instrument group, there is an option to modify the instrument type.  For current (Moxa) 

version and the previous (Axis) version, “Version 3” should be selected.  Select “Version 1” 

for the (Beck) version of electronics. 

 

In the Plot Options group, you can choose to display columns instead of fluxes on the main 

window (under ‘Last 24 hours’) by checking ‘Plot columns instead of flux’. User may want to 

select this option for scanners which are configured for fixed view.  Users can also choose to 

display a column history tab by checking ‘Plot Column History’.  The Min Colum and Max 

Column are the Y-axis range for the plots on column history tab. Similarly, users can display 

a flux history tab by checking ‘Plot Flux History’ and adjusting the corresponding min/max 

flux values. 

 

 

Figure 22 The instrument information page in the configuration dialog. 
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4.1.2 Evaluation Setting 

 

In the Evaluation-page, you can set the settings for how to perform the real-time evaluation of 

the spectra as they come in to the observatory.  

Note: if these settings are not filled in, no spectra will be evaluated, and no result obtained. 

Note: these settings will relate to the instrument which is currently marked in the list of 

scanning instruments to the left. 

 

For spectrometers with several channels, there is one evaluation-page for every channel in the 

spectrometer (these will be labelled ‘Evaluation-Master’, ‘Evaluation-Slave1’, ‘Evaluation-

Slave2’, etc). Be sure to specify at least one reference-file for each channel. 

 

The fit low and fit high values determine the pixels in the spectrum that will be used to 

evaluate the spectrums column of gas. These are given in pixels on the detector and are not 

affected if the spectra are readout as interlaced or only as partial spectra.  

 

To evaluate the spectra there need to be at least one reference-file, typically one for SO2.  

 

To add a reference-file press the ‘Add reference’ button in the lower part of the dialog.  

 

To remove one reference, select the reference you want to remove in the table and press the 

‘Remove Reference’ button.  

 

To inspect or change the properties of an already included reference file press the ‘Properties’ 

button, this will bring up the ‘Reference Properties’-dialog which lets you change the settings 

for the references.  
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Figure 23. The evaluation settings page in the configuration dialog. 

 

4.1.3 Communication Setting 

 

On the left tree list, select the scanning instrument that you are going to configure. Then you 

can set the communication parameters for this instrument. There are three communication 

types to choose from – “Serial Point-to-Point”, “FreeWave – Serial Point-to-Multipoint”, and 

“FTP”. 

In these three communication settings, “Sleep from” and “To” are common parameters, which 

are used to set the sleeping time for the scanner so that the scanner stops working at night and 

restart in the next morning. They are common for all the settings.  “Sleep From” is the time to 

quit scanning. “Sleep To” is the time to restart the scanning. 

 

(1) Serial Point-to-Point 

The first setting is “Serial Point-to-Point”. This setting is used when there is only one scanner 

working and the communication is via serial cable or a pair of radio modems. 
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Figure 24. Communication Setting - Serial Point-to-Point 

 

COM-Port – the COM port on the computer that connects the scanner by serial RS232 cable 

or by radio modem. 

 

Baudrate – the baud rate for the communication between the computer and the scanner 

or two radio modems which connects the computer and the scanner, in the default setup this is 

115200 bps. 

 

Handshake – must be “Hardware” according to the present system.  

 

Timeout – timeout is to set the timeout for the connection. If you find out that connection is 

not good, you can try to increase timeout value.  

 

Connection interval – the time between two attempts to download files from the instrument. 

Since one scan takes 5 minutes or more (depending on the conditions), it is good to have a 

connection interval somewhere from 2 to 10 minutes. 

 

(2) FreeWave – Serial Point-to-Multipoint 

The second setting is “FreeWave - Serial Point-to-Multipoint” (it is only applied for 

FreeWave radio modems). This setting is used when there is more than one scanner working. 

The computer at observatory communicates with several FreeWave radio modems. In this 

setting panel, COM-PORT, baud rate, timeout and connection interval have same meanings as 

the “Serial Point-to-Point” settings. 

RadioID / Callbook number – this parameter can be either the ID of the radio modem which 

connects with that scanner, or the number in the master radio modem’s callbook. It must refer 

to the configuration of the radio modem settings (more details in Appendix III).  
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Figure 25. Communication Configuration – Serial Point-to-Multipoint with FreeWave Radio Modem 

 

(3) FTP 

This setting is used when the scanner works as an FTP server and when the communication is 

done through the Ethernet port of the instrument. This is the default operating mode used 

with the current version of the NOVAC instruments. 

 

IP-Address – the IP address of the scanner. 

 

Username – the user name required to login to the FTP server inside the instrument. The 

default is “novac” 

Password – the password required to login to the FTP server inside the instrument. The 

default is “1225” 

Timeout – timeout is to set the timeout for the connection. If you find out that connection is 

not good, you can try to increase timeout value.  
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Figure 26. Communication Setting – FTP 

 

In the Moxa version of the NOVAC instrument, the Ethernet configuration of the embedded 

PC is performed by editing the ‘interfaces’ file in the network directory. See section 3.2.1 

Give your computer a static IP address. 

 

 

4.1.5 Wind Configuration 

 

Unfortunately, wind measurements are currently not available in the Moxa instrument 

version. However, we hope to re-establish this functionality in the near future. Once this is 

resolved, the below instructions will apply. 

 

In systems where the spectrometer has two or more channels configured, there will also be 

one ‘Wind’ page in the configuration dialog. If the system is such that the channels are 

configured to be able to make wind speed measurements, the program is able to automatically 

tell the NOVAC Scanning instrument to start these wind-measurements and to evaluate the 

result from them. 

 

The check-box ‘Do wind speed measurements automatically’ enables or disables the use of 

automatic wind-speed measurements. This is by default turned off. 

 

In this page it is possible to set how often the automatic wind-speed measurements should be 

performed (by default every 60 minutes) and how long each measurement should be (by 

default 20 minutes). 
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There are some conditions for when to perform the wind-speed measurement. No wind 

measurement can be performed by an instrument which does not see the plume from the 

volcano.  

 

In addition, the plume must be close to the zenith-position of the instrument for the 

measurement to give any result. It is in this page possible to specify how many degrees from 

zenith the centre of the gas-plume can be for the system to perform automatic measurements 

of the wind-speed. 

 

It is also required that the position of the plume is relatively stable, i.e. there cannot be large 

fluctuations in the wind-direction when performing wind speed measurements. An automatic 

wind-measurement is therefore only started if the position of the centre of the plume has not 

changed considerably during some period. By default, this period is set to 3 scans. 

 

 

 

Figure 27. The Configuration page for automatic wind-measurements in the configuration dialog. This is 

only available for systems with one spectrometer with two or more channels. 

 

4.2 Global Settings 
The ‘Global Settings’ tab contains settings for the properties of the program which are not 

connected to any individual instrument. 
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Figure 28. The Global Settings page in the configuration dialog. 

 

Output Directory: 

In configuration dialog, the “Global Setting” tab is to set the output directory for all the results 

that the program gets. All data that the system collects will be saved in this directory, and all 

temporary files generated will be put here. It is necessary that the user running the program 

has write-access to the specified directory. 

 

Wind Field File 

The NovacProgram can read in a wind-field from a file in a specific format. The wind-field 

file contains the wind field at specific times of day and for scans collected during the day(s) 

specified in the file, the flux will be calculated using a wind-field interpolated between the 

specified times. This file can be located either on the local computer or on the NOVAC FTP-

server and can be reloaded at any given interval. The location of the file and the number of 

minutes between each re- reading of this file should be specified in the ‘Wind Field File’ 

group. For the format of these wind-field files, see the section ‘5.4.6 Wind field file’ below. 

 

Start Up 

The program’s start-up-mode can also be specified here in the ‘Start up’ group. If ‘Manual’ is 

selected the user must press the start button in the toolbar on the main-page to start the 

measurements. If ‘Automatic’ is selected, the program will automatically start the 

measurements when started. 

 

Data Upload Server 
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In the ‘Data Upload Server’ group the user can specify a server to which to upload the 

spectral and evaluated data in real-time using FTP or SFTP. The username and password to 

log in to this server must also be specified. This is typically used to upload the data to the 

NOVAC database in Gothenburg.   

 

Starting in version 3.1, the FTP upload server username and password are no longer stored in 

configuration.xml.  It is stored in ftplogin.xml.  

 

Starting in version 3.2 SFTP protocol is supported for uploads but requires each observatory 

to acquire an account (login and password) which supports this. FTP uploads will eventually 

be disabled.  If you have not already been contacted with your observatory’s account info, 

request one by e-mailing dnorgaard@usgs.gov.  

 

To support SFTP, libcurl.dll, libcrypto-1_1.dll, and libssl-1_1.dll are now shipped with the 

software. This DLL is required to be in the same directory as the NOVAC Program 

executable for the software to work.  

 

Data Upload Server - Advanced 

If the local internet connection is slow or shared with some other instruments, it is possible to 

restrict the time when the program can upload data. By pressing the ‘Advanced’ button it is 

possible to define a time interval during which the NovacProgram will try to upload data. The 

times are in local time of the computer that the NovacProgram is running on. 

 

 

Figure 29. The Advanced Data Upload settings make it possible to restrict the time of day during which 

the NovacProgram will use the internet connection. 

 

Publishing Results: 

The NovacProgram can be made to save an image with the contents of the column plot and 

the flux plot in the main window each time a scan is received from one connected instrument. 

In the ‘Publishing Results’ group the settings for these savings can be specified. The available 

file-formats for the saved images is Portable Network Graphics (.png), Windows Bitmap 

(.bmp), JPEG (.jpg) or GIF (.gif). The images will be saved in the directory specified under 

‘Local Directory’ which has to be on the local computer. Each image-file will have a file-

name which corresponds to the file-name of the saved .pak-files in the output-directory and 

they will be stored under a sub-folder containing the current date.  

 

Shell: 

For reasons of automatization, the NovacProgram can be made to call an external software or 

script for each time a scan has been downloaded from one connected instrument. 
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It is possible to specify two scripts/external software: 

• One script which will be called when one scan has been downloaded and evaluated. 

The script will be called with two parameters, the first is the full filename and path of 

the .pak-file which has been stored in the output-directory, the second is the full 

filename and path of the .txt-file containing the evaluation results of the scan. 

• One script which will be called when one image-file has been generated. The script 

will be called with one parameter; the file name and full path of the image file. If the 

check-box ‘Publish Result’ is not checked or an illegal path is supplied under ‘Local 

Directory’ then this script will never be called. 

4.3 Saving the Settings 
When pressing the ‘Save’ button in the bottom part of the configuration dialog, the dialog is 

closed, and the settings are saved to the file ‘configuration.xml’ in the same directory as the 

NovacProgram. The login (username and password) for the FTP Upload Server is stored in a 

separate configuration file ‘ftplogin.xml’.  

 

Note: the changed settings will not take effect until the program is restarted! 

 

5.  Data collection 
 

There are two ways to start data collection.  

• Automatic start. The data collection starts when the program starts. This can be set at 

configuration dialog. Click menu “Configuration → Configuration”. The 

configuration dialog will show up. Change the “Start up” under “Global Settings” to 

‘automatic’. Restarting the program will automatically start the data collection. 

• Manual start. The procedure is as following: 

Manually start: Click the menu “Control → start” or click  on the toolbar.   

5.1 Running, sleeping 
 

When starting the program, the main window is shown. For each spectrometer that is 

configured in the configuration file ‘configuration.xml’ there is one page in the main window, 

where the name of the tag is the name of the site of the instrument. 

 

5.1.1 Main Window 
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Figure 30 Main window on start up 

 

When the program is running and collecting data, the evaluated results will be shown in the 

page with the corresponding serial-number and in the ‘Flux Overview’-page.  

Note: results from scanning instruments which are connected to the network but not 

configured through the configuration dialog will not be shown at all. 

 

 

Figure 31. The different pages in the main window. There is one page for each spectrometer configured in 

the configuration dialog and one ‘Overview’ page which shows a summary of all configured 

spectrometers. The name of each page is the same as the serial-number of the spectrometer. 

 

The colour of the “Scanner Status” shows the current status of the scanner 

• Green light: the instrument is ok 

• Yellow light: the instrument is sleeping 

• Red light: the program cannot contact the scanner 
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The colour of the “Evaluation Status” shows the current status of the spectral evaluation 

• Green light: the data are ok 

• Yellow light: either no spectral data received yet or there were some corrupted spectra 

in the last scan downloaded 

• Red light: either the spectral evaluation failed or there were several corrupted spectra 

in the last scan downloaded 

 

 

Figure 32. The status indicators in the main window shows the status of the scanner itself and the status of 

the spectral evaluation. 

 

The program’s routine work is to begin to work in the morning and will continuously check 

the connected scanners for spectrum files. When there is a spectra file named *.pak in one 

scanning instrument, it will be downloaded.  

 

At night, the NovacProgram stops running according to the sleep time which is set in the 

communication configuration. It sends message to the scanner so that the scanner will exit at 

night. When the scanner is not running, the “Scanner status” turns to yellow.  

 

As soon as the spectrum file is downloaded, it will be processed. If the spectra file contains a 

full scan, it will be evaluated. The evaluation result will be shown on the screen. If the file 

does not contain a full scan, it will not be evaluated. The incomplete scan will be moved to 

“Temp” folder under the output directory.  

 

The last spectra file downloaded will be displayed in the ‘Last Scan’ plot area.  The red bars 

are the column values in ppmm of the last measured scan. The white and yellow squares are 

the maximum intensities of the whole spectrum and the maximum intensity in the fit-region 

(between fit low and fit high) respectively. The vertical yellow line indicates the software’s 

guess for the position of the centre of mass of the plume. 

 

 

Figure 33. The column plot in the main window.  

 

 

The ‘Last 24 hours’ plot area contains the flux values from the last 24 hours in UTC time.  If 

the ‘Plot columns instead of fluxes’ option is selected in the Scanning Instrument -> Plot 

Options configuration, then columns from the last 24 hours will be shown. 
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The status message box on the window will show the updating messages. The top message is 

the latest message. All these messages are saved as “Output\DATE\StatusLog.txt” (where 

DATE is today’s date) under the output directory.  The status message box is shown under all 

tabs. 

 

 

Figure 34 Status Message Box 

 

5.1.2 Overview Tab 

 

The ‘Overview’ tab shows the flux-results received in the last 24 hours from the different 

scanning instruments.  

 

 

Figure 35 Overview tab 
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5.1.3 Instrument Tab 

 

There is one page named ‘Instrument’ which shows part of the available instrumental data. 

Currently the graphs show the temperature, battery voltage and exposure-times today for each 

of the instruments plus the link speed for each of the spectral file downloads done in last 24 

hours. 

 

 

Figure 36  Instrument tab 
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5.1.4 Column History Tab 

 

For each spectrometer configured, if the ‘Plot Column History’ option is selected in the 

Scanning Instrument->Info->Plot Options configuration, then a column history tab is shown.  

It shows column plot for last 24 hours, 10 days, and 30 days. The history data is read from the 

evaluation logs found in the Output Directory specified under Global Settings configuration.  

It may therefore take a few seconds to load this tab initially.  The ‘Last 24 hours’ plot will 

update as new data is received.  The 10-day and 30-day plots will update once a day when 

new data is first received on the new UTC day. 

 

 

Figure 37 - Column History tab 

 

5.1.4 Flux History Tab 

 

For each spectrometer configured, if the ‘Plot Fux History’ option is selected in the Scanning 

Instrument->Info->Plot Options configuration, then a flux history tab is shown.  It shows flux 

plot for last 24 hours, 10 days, and 30 days. The history data is read from the flux logs found 

in the Output Directory specified under Global Settings configuration.  The ‘Last 24 hours’ 

plot will update as new data is received.  The 10-day and 30-day plots will update once a day 

when new data is first received on the new UTC day. 
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Figure 38 Flux History tab 

 

5.1.5 Wind Measurement Tab 

 

If any connected instrument contains a double-spectrometer, then there is also one page 

named ‘WindMeas’. The main graph in this page shows the result of the wind-measurements 

performed today by each of the instruments that can perform wind speed measurements. 

 



   NOVAC Scanning DOAS Manual 

 

 45 

 

Figure 39  Wind Measurement tab 

 

5.2 Stopping the data collection 
Click the menu “Control->Exit” or the red button with a white cross in the upper right part of 

the window. 

 

5.3 Explanation of messages in NOVAC software 
The meaning of the messages shown in the status message box of the NOVAC Software can 

be found here. They are listed in alphabetic order. 

 

Message Description Solution 

 All instruments sleep for 

10 hours. The scanner will 

start working at 12:00:00 

The scanners will stop working for 10 

hours. At 12:00:00 they will wake up. 

__ 

Begin to download 

STATUS.DAT 

Begin to download STATUS.DAT file. 

This file is to check the working status 

of the scanner. 

__ 

Begin Evaluation of 

Spectrum File 

One downloaded spectrum-file will be 

looked at. If it contains complete scans, 

they will be evaluated 

__ 

Cannot switch to shell Cannot switch to command mode. The 

communication might be broken. Or the 

Restart the program. If 

it cannot recover, use 
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scanner has no power.  HyperTerminal to see 

whether the scanner is 

running. 

Check file size Check the size of the file to be 

downloaded 

__ 

Could not calculate flux, 

no good data points in 

measurement 

The spectra in one scan have too low 

intensity. The flux in this scan is not 

calculated and is set to 0.  

__ 

Could not read sky-

spectrum in file… 

There was no spectrum in the scan-file 

which is a sky-spectrum. The scan-file 

is corrupt 

If problem persist, 

consider re-formatting 

the Compact Flash card 

in the embedded 

computer 

Could not read dark-

spectrum in file… 

There was no spectrum in the scan-file 

which is a sky-spectrum. The scan-file 

is corrupt 

If problem persist, 

consider re-formatting 

the Compact Flash card 

in the embedded 

computer 

Downloaded file does not 

contain a complete scan 

There was one incomplete scan in the 

downloaded file. The incomplete scan 

will be moved to the ‘Incomplete’ folder 

in ‘Temp’ and later to ‘Lost’ if no 

matching end of the scan can be found 

__ 

Download finished File is downloaded. __ 

 

File size of upload.pak 

OK 

The downloaded file has correct size, 

which means that it is a complete file. 

__ 

 

 

  

Found spectra which are 

not evaluated. Will 

evaluate it now. 

The program has found downloaded 

spectra files at start up. The spectra will 

be evaluated 

__ 

Have exited Kongo. Will 

wake up at 12:00:00 

The scanner has stopped working. It will 

be restarted at 12:00:00. 

__ 

Initiated serial port The serial port is initiated. __ 

Kongo is running The scanner is working.  

Kongo has exited The scanner has stopped.  

Moved incomplete scan 

file to folder for lost scans 

The program has given up on finding 

the continuation of one downloaded 

incomplete scan. The file will be moved 

to the ‘Lost’ folder 

__ 

Program successfully 

started 

Program is started. But it doesn’t mean 

communication is initiated now. 

__ 

Received new scan from: 

I2J5897 

One scan from I2J5897 spectrometer is 

evaluated. 

__ 

Received full scan from 

%s. Scan evaluated and 

stored as %s 

One full scan has been received. The 

evaluation was successful. 

__ 

Received incomplete scan 

from %s. Scan evaluated 

One incomplete scan has been received. 

The scan was evaluated anyway and the 

__ 
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and stored evaluation was successful. 

Reboot remote PC Reboot remote PC so that the scanner 

starts to work 

__ 

Scan evaluated, the scan 

file was moved to the 

storage folder 

The downloaded spectra is evaluated. 

Scan files will be moved to folder 

“Scan” 

__ 

Set remote PC time The program will set remote PC time. __ 

set remote PC to local PC 

time 2006-4-25 09:46:10 

The program has set remote PC time 

same as local computer’s time. 

__ 

Spectrum XX in pak file is 

corrupt, checksum 

mismatch 

There was an error in one of the spectra 

in one downloaded spectrum file. This 

spectrum cannot be used.  

If problem persist, 

consider re-formatting 

the Compact Flash card 

in the embedded 

computer 

Switch remote PC to 

command mode, No. 0 

Switch remote PC’s mode to command 

mode so that command can be received. 

__ 

UPLOAD.PAK is not 

found 

UPLOAD.PAK in the scanner is not 

ready to download yet. 

__ 

Wake up remote PC Restart the scanner to begin to work. __ 

 

Will sleep 4.4 seconds The program will query the scanner in 

4.4 seconds.  

__ 

 

5.4 Output Files 

5.4.1 Local Folders Structure  

The program works under the output path that you have set in “Global Setting” configuration 

dialog (see Figure 28). Under this folder the program generates three folders – “Output”, 

“Lost”, and “Temp”. For example, the serial number of the spectrometer inside the Scanning 

DOAS is I2J5897. The working directory structure is as follows: 

 

  Working Directory 
 |__ NovacProgram.exe 
 |__ configuration.xml 

  Output Directory 

  |__  Output 

 | |__  2006.04.24 

|  |__  I2J5897 

 |              | |__  Scans 
 |  | | |__ I2J5897_2006.04.24_13.36.12_0.pak 
 |  | | |__ I2J5897_2006.04.24_13.36.12_0.txt 
 |  | | |__ ……pak 
 |  | | |__ ……txt 
 |  | |__ FluxLog_I2J5897_2006.04.24.txt 
 |  | |__ EvaluationLog_I2J5897_2006.04.24.txt 
 |  | 
 |  |__ StatusLog.txt 
 | 

 |__   Temp 

 | |__  IncompleteScans 
 | |__ xxxxxxxxx.pak 
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 | |__ STATUS.DAT 
 | |__ cfg.txt 
 | |__ fileList.txt 

 |__   Lost  
  |__ xxxxxxx_0_0.pak 
  |__ … 

 

 “Output” – stores all the output data files and log files. In this folder, there are folders named 

by the dates, which stores log files – Evaluation_ErrorLog.txt, and StatusLog.txt. There is 

also a folder named by serial number, for example I2J5897. That folder stores all 

uncompressed spectra. 

“Temp” – stores temporary incomplete scans to be completed, STATUS.DAT and cfg.txt. 

 “Lost” – stores incomplete scans which are not possible to be recovered. 

 

5.4.2 Evaluation log 

The evaluation result of all spectra collected for one day are stored in the Evaluation log file. 

The name of the evaluation-log contains the date when the spectra were collected and the 

name of the spectrometer that collected them. The evaluation result of one scan can be found 

in two locations, in the same directory as the .pak-files are small .txt files with the same name 

as one .pak-file, except for the file ending. These small text files contains the evaluation result 

of the .pak-file with the same name. In the parent directory of the ‘Scans’ directory one large 

Evaluation log can be found, this contains the evaluation results of all scans collected during 

the day and is merely a combination of all the small text files. 

 

The evaluation log file consists of three segments, the scaninformation, fluxinfo and 

spectraldata. 

 

Scan Information 

The scan-information segment contains general information about the scan. This segment is 

found in the top part of the evaluation log and starts with the line ‘<scaninformation>’ and 

ends with the line ‘</scaninformation>’. As of version 2.1 of the evaluation log files, the 

following items can be found in this section; 

 
date The date when this scan was collected. In UTC. 
starttime The time of day when the collection of this scan began. In 

UTC 
compass The compass direction of the instrument that was used to 

collect the scan. 
tilt The tilt of the instrument at the time of the collection of this 

scan. 
lat The latitude of the instrument. Information taken from the 

GPS of the instrument. Unit is degrees and decimal degrees. 
long The longitude of the instrument. Information taken from the 

GPS of the instrument. Unit is degrees and decimal degrees. 
alt The altitude of the instrument. Information taken from the 

GPS of the instrument. Unit is meters above sea level. 
volcano The name of the volcano that this scan monitored. 
site The name of the site where the instrument collecting this scan 

was located at the time the scan was downloaded. 
observatory The name of the observatory responsible for the instrument 
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collecting this scan. 
serial The serial number of the spectrometer that collected this scan. 
spectrometer The model of the spectrometer that collected this scan. 
channel The channel of the spectrometer used. This is normally 0, 

however for SD2000 spectrometers, two spectrometers are 

present in one box and then 0 corresponds to the ‘Master’ 

spectrometer and 1 corresponds to the ‘Slave’ spectrometer. 
coneangle The cone angle of the instrument that collected this scan. 90 

means a flat scanner and 60 is a cone scanner. 
interlacesteps Which pixels of the detector of the spectrometer that was used 

to collect this scan. A value of 1 corresponds to every pixel of 

the detector. A value of 2 corresponds to every other pixel of 

the detector, etc. 
startchannel The first pixel of the detector of the spectrometer that was 

used to collect the spectra in this scan. A value of 0 

corresponds to starting at the first pixel on the detector. 
spectrumlength The length of the spectra collected in this scan. 
flux The calculated flux of this scan, in kg/s. See the section 

‘fluxinfo’ below for more information. 
battery The input voltage of the ManneBox at the start of this scan. 
temperature The temperature of the instrument at the start of this scan. 
mode The measurement mode of this scan. Can be either; 

‘plume’ – normal flux measurement 

‘wind’ – dual-beam wind speed measurement 

‘composition’ – composition measurement 

‘direct_sun’ – direct sun measurement 

‘stratosphere’ – measurement in stratospheric mode. 
instrumenttype The type of this instrument, can be either ‘gothenburg’ or 

‘heidelberg’ 
version The version of this evaluation log file. Currently equal to 2.1. 
softwareversion The version of the NovacProgram that was used to create this 

evaluation log file. 
compiledate The date the NovacProgram creating this evaluation log file 

was compiled. 

 

Fluxinfo 

This section contains information on the calculated flux from this scan and some of the 

information that was used to calculate this scan. As of version 2.1 of the evaluation log files, 

the following items can be found in this section; 

 
flux The calculated flux from this scan. In kg/s. 
windspeed The wind speed that was used to calculate the flux from 

this scan. In m/s. 
winddirection The wind direction that was used to calculate the flux 

from this scan. In degrees from north with increasing 

numbers clockwise. 
plumeheight The altitude of the plume above the instrument (in 

meters) that was used to calculate this flux. 
windspeedsource The source of the wind speed used to calculate this flux. 
winddirectionsource The source of the wind direction used to calculate this 
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flux. 
plumeheightsource The source of the plume height used to calculate this 

flux. 
compasssource The source of the compass direction of the instrument. 

Can be either ‘user’ or ‘compassreading’ 

 

Spectraldata 

This section contains information of each of the spectra collected in the scan, including the 

sky and dark spectra. This section contains one line for each spectrum collected in the scan. 

The header of the table found in this section can be found before the line ‘<spectraldata>’. As 

of version 2.1 of the evaluation log files, the following columns can be found in this section; 

 
scanangle Only for instruments of version 1: The scan angle for the 

current spectrum. Unit is degrees. 
observationangle Only for instruments of version 2: The observation angle for 

the current spectrum. Unit is degrees. 
azimuth Only for instruments of version 2: The azimuth angle for the 

current spectrum. Unit is degrees. 
starttime The UTC time when the spectrum collection began. 
stoptime The UTC time when the spectrum collection was finished. 
name The name of the spectrum, from ‘cfg.txt’ in the instrument. 
specsaturation The saturation of the pixel with maximum intensity in the 

current spectrum. This is a value between 0.0 and 1.0 saying 

how large portion of the available dynamic range of the 

spectrometer is used, 1.0 meaning the spectrum is saturated 

and 0.0 meaning that the spectrum is completely dark. 
fitsaturation The saturation of the pixel with maximum intensity within 

the range of pixels used in the spectral fit. 
counts_ms The number of counts for the pixel with highest intensity 

divided by the number of milliseconds of exposure-time. 

Gives information on the sensitivity of the spectrometer. 
delta The delta (peak-to-peak difference) of the residual of the fit. 
chisquare The chi2 of the fit. 
exposuretime The exposure-time of the current spectrum, in milliseconds. 
numspec The number of detector read-outs that were co-added to 

generate this spectrum. 
column(…) The evaluated column of the species/cross section specified 

in the parenthesis. There is one column like this for each 

trace gas evaluated for in the fit. 
columnerror(…) The column error of the species/cross section specified in the 

parenthesis. There is one column like this for each trace gas 

evaluated for in the fit. 
shift(…) The shift of the species/cross section specified in the 

parenthesis. There is one column like this for each trace gas 

evaluated for in the fit. 
shiftError(…) The error in the shift of the species/cross section specified in 

the parenthesis. There is one column like this for each trace 

gas evaluated for in the fit. 
squeeze(…) The squeeze of the species/cross section specified in the 

parenthesis. There is one column like this for each trace gas 
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evaluated for in the fit. 
squeezeError(…) The error of the squeeze of the specie/cross section specified 

in the parenthesis. There is one column like this for each 

trace gas evaluated for in the fit. 
isgoodpoint Flag determining of this spectrum has been judged as a good 

spectrum by the real-time program. 0 corresponds to bad 

spectrum, 1 corresponds to good spectrum. 
offset The electronic offset of the current spectrum. In counts. Note 

that this is a sum, i.e. if the spectrum is a sum of 15 read outs 

then this is 15x the offset of a single spectrum. 
flag The ‘flag’ that was specified in the cfg.txt file in the 

instrument for the collection of this spectrum. 

5.4.3 GeometryLog 

Whenever two complete scans, collected closely in time, see the plume the information in the 

two scans can be combined to calculate the direction of the plume and the altitude of the 

plume. The calculated plume heights and wind directions can be found in the GeometryLog 

file. The file contains the following columns; 

 
Volcano The name of the volcano that is monitored with the 

instruments used 
EvaluationLog1 The file name of the evaluation log of one of the scans 

that was used to make this calculation 
EvaluationLog2 The file name of the evaluation log of one of the scans 

that was used to make this calculation 
AverageStartTime The average of the start times of the two scans that were 

combined. 
PlumeCentre1 The scan angle in which the centre of mass of the plume 

is found in scan 1 
PlumeCentre2 The scan angle in which the centre of mass of the plume 

is found in scan 2 
ScannerDistance The distance between the two scanners that collected the 

used scans. In meters. 
CalculatedPlumeHeight The calculated altitude of the plume, in meters above the 

lowest of the two instruments used. 
TotalPlumeHeight The calculated altitude of the plume, in meters above sea 

level. 
PlumeHeightError A value describing the uncertainty in the calculated 

plume height. This is a minimum value only!! 
WindDirection The calculated direction of the plume. In degrees from 

north, increasing clockwise. 
WindDirectionError A value describing the uncertainty in the calculated 

plume direction. This is a minimum value only!! 
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5.4.4 FluxLog 

The fluxes calculated in real-time are stored in the FluxLogs. The flux-log contains a small 

header describing the instrument; 

 
serial The serial number of the spectrometer used to collect the 

data found in the current flux-log file 
volcano The name of the volcano that these fluxes are for. 
site The name of the site where the instrument is located. 

 

Following the header is a table of calculated fluxes. Each scan generates the one line in the 

flux log file. The table contains the following columns; 

 
scandate The date when the scan was collected. In UTC. 
scanstarttime The time when the scan started. In UTC. 
scanstoptime The time when the scan was completed. In UTC. 
flux_[kg/s] The calculated flux of the scan. Unit is kilograms per 

second 
windspeed_[m/s] The wind speed that was used to calculate the flux. Unit 

is meters per second. 
winddirection_[deg] The wind direction that was used to calculate the flux. 

Unit is degrees from north, increasing clockwise 
windspeedsource A string describing the source of the wind speed. This 

can be ‘user’ if given by the user through the interface. 
winddirectionsource A string describing the source of the wind direction. 

This is typically ‘user’ – when given by the user 

through the interface. 
plumeheight_[m] The assumed altitude of the plume (in meters above the 

instrument collecting the scan) that was used to 

calculate the flux. 
plumeheightsource A string describing the source of the plume height used. 

This is typically ‘user’ – i.e. given by the user through 

the interface. 
compassdirection_[deg] The compass-direction of the instrument. This is the 

direction in which the instrument points, in degrees 

from north, increasing clockwise. 
compassource The source of the compass-direction. Can either be 

‘user’ when specified in the cfg.txt file in the 

instrument or ‘reading’ when read out from a compass 

attached to the instrument. 
plumecentre_[deg] The scan angle where the centre of the plume was 

calculated to be.  
plumecompleteness_[%] The calculated completeness of the scan. This is a 

number between 0.5 and 1.0 describing how large 

portion of the plume is seen. 1.0 means that the entire 

plume is captured by the scan, 0.5 means that the plume 

is on the edge of the scan and that the calculated flux is 

thus underestimating the true flux. This value is 

however not a percentage of the observed plume, only a 

parameter that tells if the scan see clean horizons on the 
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sides of the plume or not. 
coneangle The cone angle of the instrument. This is either 90, i.e. 

a flat scanner, or 60 which is a cone scanner. 
tilt The tilt of the instrument that was assumed when 

calculating the flux. 
okflux Flag describing whether the software judged the scan to 

be a good measurement or not. 0 corresponds to a bad 

measurement, 1 corresponds to a good flux 

measurement. 
temperature The temperature of the instrument when collecting this 

scan. This is read out from the temperature sensor 

connected to the instrument. Value is 0.0 if no sensor is 

available. Information is supplied for reasons of 

instrument monitoring. 
batteryvoltage The input voltage to the ManneBox at the start of the 

scan. Information is supplied for the reason of 

instrument monitoring. 
exposuretime The exposure time used for the sky measurement in this 

scan. Can be used to monitor the status of the 

instrument. 

 

5.4.5 StatusLog 

A file containing the messages shown in the ‘Status Messages’ list box in the bottom of the 

main window in the NovacProgram. This file contains useful debugging information and 

should always be supplied when reporting bugs/strange behaviour of the program. 

 

5.4.6 Wind field file 

When re-evaluating scans with the NovacProgram it is convenient to read out the plume 

parameters (speed, direction and height of the plume) from a single file. This can be called 

when re-evaluating fluxes for example, by clicking on ‘Analysis->Flux->File->Import Wind 

Data->Import WindField from file’ and selecting on the browser the respective file.  
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Figure 40. Selecting a wind file for flux-re-evaluation with the NovacProgram. 

The name assigned to the file is not important, but it should be a *.txt file containing the 

following fields in this format: 

 
date time ws wd ph 

2015.10.20 10:00 3 360 1500 

2015.10.20 11:00 2.3 350 1200 

2015.10.20 12:00 2.8 360 1350 

2015.10.20 13:00 3 360 1750 

2015.10.20 14:00 3.3 10 2100 

2015.10.20 15:00 2.7 350 1900 

2015.10.20 16:00 2.8 310 1800 

 

 

The first column is the date in yyyy.mm.dd format, the second is time in hh:mm format, the 

third is wind speed in n.n format, the fourth is wind direction in n.n format and the last is 

plume height in n.n format. As always, date and time should be UTC (to correspond with the 

measurement time), wind speed is positive, wind direction is measured clockwise from north 

and plume height is the altitude of plume above the station (which means that for each 

scanner a new plume height column should be defined). The last column is optional, if it is 

not defined the NovacProgram will adopt a default plume height value (typically the 

difference in altitude between the scanner and the volcano’s summit). 

 

The information contained in the wind file can be extracted from the GeometryLog (except 

wind speed), from a meteorological station, a model (ex., NOAA-Ready model:  

https://ready.arl.noaa.gov/READYamet.php), or elsewhere. When read out, the 

NovacProgram will perform an interpolation to select the closest values in time to each 

measurement.  

https://ready.arl.noaa.gov/READYamet.php
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6.  Post-processing SO2 data 
 

The NOVAC-Program can also be used to make a second analysis of the generated results, for 

error checking or for generation of better data if more knowledge about e.g. wind speed has 

been retrieved. 

 

6.1 Post flux calculation 
The post flux calculation dialog can be reached from the menu in the main window by 

pressing ‘Analysis→Flux’. Through the post-flux calculation dialog, the user can calculate the 

flux from a generated evaluation (or re-evaluation) – log file.  

 

Open the (re)evaluation –log file for which to calculate the flux by pressing the ‘Browse’-

button in the upper part of the dialog or by the menu option ‘File->Open Evaluation Log’ (not 

by typing in a file name in the empty space next to the ‘browse’ button).  

 

When the evaluation-log file has been opened, the column plot in the middle of the dialog will 

show the variation of gas column with scan angle (angle from zenith) as red bars. The 1-sigma 

errors of the spectral fit are shown as white error-bars. The maximum intensities of the spectra 

are shown as white squares. Data points which are regarded as good measurements are shown 

in a clear red colour. Data points which are regarded as not good spectra, e.g. if the spectrum 

is too dark or saturated, are shown in a dark red colour and are not used in the flux-

calculations. 

 

From the ‘View’ menu it is possible to show more information about the scans, such as 

maximum intensity in the fit region (‘Fit Intensity’), the column error (which is shown on the 

same scale as the column–bars), or the delta (peak-to-peak value of the residual) or the chi-

square of the fit. However, note that the delta- and chi-square values are shown as normalized 

values, their absolute numbers are not shown. 

 

There is some information about the currently shown scan shown above the column graph. In 

the upper left corner is shown the number of scans in the evaluation log and the index of the 

currently shown scan. In the upper right corner is shown the date when the scan started and 

the time (in UTC) when the scan started.  

 

In the middle, just above the column graph, is a small spin-control with two arrow buttons. 

Pressing the right button will show the next scan in the evaluation log and pressing the left 

will show the previous scan.  

 

It is possible to use a wind-field defined in a wind-field file (for the format see the section 

‘5.4.6 Wind field file’). In this case the wind-field used to calculate the fluxes will be 

interpolated between the data points specified in the wind-field file. To use a wind-field file in 

the calculations, go to the menu option ‘File->Import WindField’ and select the file to use. 

On successful parsing of the wind-field field, a dialog will show the number of data points 

that has been read in from the file. 
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Figure 41. To use a wind-field file to interpolate the wind-field for each scan to calculate, select a wind-

field file to use by pressing the menu-option ‘Import WindField’ and select a file to use. 

 

In the ‘Settings’ group in the lower left part of the dialog is numbers which are necessary for 

calculating the flux for the scans.  

• The flux-gas specifies which gas the flux should be calculated for (if several gases are 

evaluated for in the evaluation log) this is typically SO2.  

• The wind speed and wind direction are necessary parameters and are specified at 

plume height. Note that there can be a very large difference between the wind speed at 

ground level and the wind speed at plume height. These fields will be disabled if the 

wind speed and/or wind direction is taken from a wind-field file. 

• The plume height specifies the height of the plume above the instrument. Note that 

this is not the same as the plume’s altitude above the sea level. This field will be 

disabled if the plume height is taken from a wind-field file. 

• The compass direction is the direction in which the scanning instrument points, in 

degrees from north counted as positive in the clock-wise direction. If this is specified 

in the evaluation-log then this field is filled in automatically. 
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Figure 42. The post-flux calculation dialog. In this dialog, it is possible to perform off-line calculations of 

the flux. 

 

In the ‘offset’-group are parameters used for deciding the offset-level of the scan. When the 

gas columns in the spectra are evaluated, they are measured relative to the gas column in the 

sky spectrum, which is a zenith spectrum collected before the real measurement. If this 

spectrum has a high gas column, then the some of the evaluation will show negative numbers. 

This is not wrong but simply a result of making a relative measurement. These negative 

numbers can be compensated for by including an offset-level into the flux-calculation. This 

offset level tells the program where the ‘real’ zero-level is. The calculated offset-level is 

shown in the column graph as a dashed red line below the scan. The offset can be calculated 

automatically (default) or the user can specify an offset-level, or the user can specify the 

parameters for the calculation of the offset-level.  

 

In the ‘Deletion of bad points’-group, the user has the possibility to remove single 

measurement points from the flux-calculations. Spectra which are too dark or saturated will 

have a very high noise-level and could deteriorate the flux-calculations. Therefore, bad 

measurement points should be removed from the data set before calculating the flux. The 

program automatically detects bad measurements and marks them in a dark red colour. If the 

user finds more data points which should be marked as bad, the user can specify them in the 
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empty space in the ‘Deletion of bad points’ - group. These points will then be selected and 

appear as blue columns in the column graph. When pressing the ‘Delete Selected Points’-

button these selected points will be removed from the data set, and they will appear as dark 

red in the column graph. Data points can also be selected by intensity by moving the intensity 

slider on the left side of the column plot up or down. Data points with an intensity below the 

selected intensity of the column slider will be selected and appear in the list in the ‘Deletion 

of bad points’ – group and appear as blue columns in the column plot. Pressing the ‘Delete 

Selected Points’ – button will remove these points from the dataset.  

 

Pressing the button ‘Calculate’ in the ‘Flux’-group in the lower right corner of the dialog will 

make the program calculate the flux for the currently shown scan using the data points shown 

in clear red or in blue in the column graph. The result is shown in the empty box to the right 

of the button. The unit of the flux is selected before calculating the flux by selecting the 

desired unit in the combo-box in the right-most corner. 

 

When the program calculates the flux, it will also generate a post-flux log which is put in the 

same directory as the opened evaluation log. This log-file contains the resulting flux in kg/s, 

the wind speed, wind direction and plume height used for calculating the flux. It will also save 

the offset used and the time (typically GMT) when the spectrum was started. 

 

 

Figure 43.The estimation of errors for post flux calculation. 

 

6.2 Re-Evaluation of spectra 
If the user wants to make a second evaluation of spectra collected with the NOVAC-program, 

this can be done through the ‘Re-Evaluation’-dialog which can be found under the ‘Analysis’ 

menu in the main window. The re-evaluation dialog lets the user choose the evaluation 

parameters and can evaluate the spectra with different reference-files, with different settings 

and make advanced experiments with the spectra.  

 

The pak-files which are used in the re-evaluation dialog must be complete, single scans or 

they will not be evaluated. If the pak-file contains several scans they can be split up using the 

‘Split/Merge’ – dialog found under the ‘File’ menu in the main window. Pak-files which are 

generated by a running NOVAC-program will always be single scans, however they are not 

always complete. 

 

The re-evaluation dialog contains four pages; in each page one aspect of the evaluation is 

treated. 
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Remember that if you want to close the dialog press the ‘Close’ button in the lower right part 

of the dialog.  

NB – Pressing the ‘Close’ – button will close the dialog promptly without doing anything 

more, no settings will be saved. 

 

6.2.1 Re-Evaluation – Selecting Scans 

The first page in the Re-Evaluation dialog is the ‘Scans’ – page. Here you select the pak files 

you want to evaluate again by pressing the ‘Browse’ – button in the lower part of the dialog. 

The selected pak-files will be shown in the list in the left part of the window.  

 

In the right part of the window, you can see inspect the spectra in the pak-file and browse 

through them by pressing the left and right arrows below the spectrum-graph. The lower right 

part of the dialog shows general information about the currently selected spectrum, such as 

collection date, exposure time, number of averaged spectra or scan angle. 

 

 

 

Figure 44. The Scans-page in the Re-Evaluation dialog. Here you can select and inspect each of the the 

pak-files to evaluate. 

6.2.2 Re-Evaluation – Setting up the fit windows 

The second page in the Re-Evaluation dialog is the ‘Fit Windows’ – page. The Re-evaluation 

algorithm is based on the concept of ‘fit windows’. A fit window is a spectral region, where 

the spectrum is evaluated for one or more species. You can specify more than one fit region in 

this window, each spectrum will then be evaluated two times, one in each region. If you want, 

these regions can be overlapping or even be the same. Each fit-window has a name, and all 
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fit-windows are shown in the fit-window list in the left side of the dialog. The fit-window you 

are currently working on is the one which is marked by a blue colour in the list. 

 

For each fit window you specify the region of the spectrum that the fit-window should cover. 

The region is specified by the fit from and fit to parameters, which are same as in the 

Configuration dialog. NB In the same way as in the configuration dialog; the fit from and fit 

to are given as pixels in the spectrometer and are not affected if the spectra are read out in an 

interlaced way or as partial spectra. 

 

In the ‘Fit Type’ – group you can specify advanced options on how the evaluation should be 

performed. The default option is ‘HP, divide by sky’ (which is used in the real-time 

evaluation). In the first option each measured spectrum will be divided by the sky spectrum 

before being logarithmated. In the second option, a high-pass filtered and logarithmated 

spectrum will be included into the fitting procedure, this can be useful if there are large shifts 

between the sky spectrum and the measured spectra.  

 

In the ‘Misc.’ – group there are two options. The check-box ‘UV’ is checked by default and 

should be checked for spectra where the starting wavelength is shorter than 300 nm.  

If the check-box ‘Find Optimal Shift’ is checked, each scan will be evaluated two times. The 

first time the shift and squeeze of each spectrum will be set to 0 and 1 respectively (no matter 

what you specify for the references). The spectrum with the highest column value will then be 

evaluated one time more with the shift set to free, the program can in this way find an 

‘optimum’ value for the shift. The whole scan will then be evaluated once more, now with the 

shift set to the found ‘optimal’ shift. This only works if the scan contains a clear plume with 

high column values. 
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Figure 45. The fit windows page in the Re-Evaluation dialog. This page allows you to setup one or more 

regions in which the spectra should be evaluated. 

 

In each fit-window you can specify up to 5 references that will be fitted. To include a 

reference-file press the ‘Insert Reference’ – button, to remove a reference-file press the 

‘Remove Reference’ – button. To inspect and/or change the properties and options for a 

reference-file press the ‘Properties’ – button, this will bring up the ‘Reference Properties’ – 

dialog in which you can modify the reference-file. 

 

All the fit windows that are currently configured are shown in the list of fit-windows to the 

left. Right clicking in this list will bring up a context-menu from which you can choose to 

insert one more window.  

 

By clicking ‘Insert window’ in the context menu a new fit-window will appear in the list and 

you will be asked for a name for this new fit-window.  

 

By clicking ‘Load Window(s) from File’ you can include fit-windows which have already 

been configured and saved to a file. NB by loading a fit window from a file, the list of fit-

windows will be replaced by the windows in the file and the currently existing fit windows in 

the list will be removed. 

 

To save the current list of fit windows select ‘Save Window(s) to File’ in the context menu. 

You will be asked for a file name, and the current fit-window setup will be saved in a ‘.nfw’ 

file. This is useful if you want to make the same evaluation later, using other spectra. NB it is 
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not possible to transfer .nfw-files between computers, since they only store the path to the 

reference-files, not the files themselves. 

 

Figure 46. The context-menu in the list of fit windows. The menu is accessed by right-clicking in the list to 

the left. 

6.2.3 Re-Evaluation – Misc. Settings 

The third page in the Re-evaluation dialog is the misc. – settings page, which contains 

miscellaneous settings.  

 

In the ‘Dark Spectra’ – group you can specify what to do with spectra which are dark or could 

be considered as dark.  

1. If the option ‘Ignore Completely Dark spectra’ is chosen, then completely dark spectra 

will be skipped in the evaluation (they will not be evaluated at all). This is the default 

option, since they will not give any useful results anyway.  

2. If the option ‘Ignore spectra with intensity below:’ is chosen, then you can specify a 

limit intensity and a pixel number around which to calculate the intensity. Spectra 

which have a lower intensity at this pixel-number will be ignored in the evaluation. 

3. If the option ‘Don’t ignore anything’ is selected then all spectra will be evaluated, no 

matter how little light they have. 

 

In the ‘Saturated Spectra’ – group you can specify what to do with spectra which have too 

high intensity. 

1. If the option ‘Ignore Saturated spectra’ is chosen, then spectra which have a maximum 

saturation ratio of 100% will be ignored. 

2. If the option ‘Ignore spectra with intensity above’ is chosen, then you can specify a 

limit intensity and a pixel number around which to calculate the intensity. Spectra 

which have an intensity higher than the limit intensity around the specified pixel-

number will be ignored. 

3. If the option ‘Don’t ignore anything’ is selected then all spectra will be evaluated, no 

matter how saturated they are. 
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Figure 47. The Misc. page in the Re-Evaluation dialog contains misc. options for the evaluation. 

 

In the ‘Sky Spectrum’ – group you can specify the options for how to select the sky-spectrum. 

The default option is to use the first spectrum in the scan, but it is also possible to use an 

average of all good spectra in the scan, which can possibly increase the signal to noise ratio in 

the evaluation. Another option is to use a specific spectrum number in the scan, this can be 

useful if e.g. the zenith spectrum is saturated. The fourth option is to specify a spectrum which 

can be used as sky spectrum. If a pak-file is specified, then only the first spectrum in the pak-

file will be used. A user specified sky-spectrum must be corrected for dark-current and offset. 

 

In the ‘Misc.’ – group are even more obscure options. If some old ScanDOAS spectra have 

been imported to a pak-file they may be summed or averaged depending on the version of 

ScanDOAS used. This button enables the use of spectra which are averaged. 

 

To simplify the use of the re-evaluation dialog, these settings can be stored in a settings file 

for more easy use on the next occasion. To store the settings, press the button with a picture of 

a small floppy disk in the upper right corner of the page. To read in these settings from 

previously stored file, press the ‘open’ button in the upper right corner of the page. 

 

6.2.4 Re-Evaluation – The final evaluation 

The final page in the re-evaluation dialog is the ‘Do Evaluation’ – page.  
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Pressing the ‘Do Evaluation.’ button will start the evaluation of the selected spectra using the 

options setup in the earlier pages. The result of the evaluation will be shown in the two graphs 

on this page.  

 

The left graph shows the measured spectrum in the fit-region or the residual of the fit 

depending on the settings of the radio button below the graph. 

 

The right graph shows the result of the evaluation. It shows, in blue, the reference-file which 

is selected in the list below the graph (in Figure 48 this is SO2) scaled to the evaluated column 

value. Below this is, in red, the same scaled reference-file plus the residual of the fit. This 

enables inspection of the quality of the fit. If the residual is small and lacks structures, then 

the evaluation is ok.  

 

Below the right graph is the evaluated column value of the currently selected reference-file 

shown for the last evaluated spectrum. The shift and squeeze used for the fit are also shown 

together with the delta and chi-square values which are used as a quality measure of the 

fitting, smaller values are better. 

 

 

 

Figure 48. The final page in the re-evaluation dialog. Here you can perform the evaluation of the selected 

pak-files using the specified options and inspect the result. 

 

By default, the evaluation runs without making any pause between the spectra. However, if 

checking the ‘pause’ check button in the left half of the screen, the evaluation will make a 

pause after evaluating each spectrum. The program will evaluate next spectrum when the user 

presses the ‘Next’ – button, which is situated where the ‘Do Evaluation’ – button was before. 
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The evaluation can always be interrupted by pressing the ‘Cancel’ button to the right of the 

‘Do Evaluation’/’Next’ – button. NB DO NOT PRESS THE ‘CLOSE’ BUTTON ON THE 

BOTTOM ROW WHEN THE EVALUATION IS RUNNING. 

 

6.3 Setup inspection 
The setup-inspection dialog can be opened by selecting ‘Analysis→Setup’ in the menu in the 

main window. The setup inspection dialog can handle up to four evaluation logs and show the 

result of the measurements on a map. 

 

To open an evaluation log, press one of the ‘Browse’ – button. The evaluation log file must 

contain GPS information, which some older evaluation-log files does not do.  

 

When the evaluation log has been opened, the program will calculate which NOVAC volcano 

is closest, and calculate the distance from the instrument to the summit of the volcano. If the 

compass-direction is specified in the evaluation log, the program can make a small map of the 

scans in the evaluation log file. NB the scale of the scan is entirely depending on the plume 

height which must be supplied by the user. 

 

The single red square on the map is the volcano, the black square is the scanning instrument, 

and the line of squares of varying colour is the result of the scan. The scan is represented on a 

relative scale, with blue being the lowest column values and red showing the highest.  

 

For a single scan, the program can calculate the wind direction by knowing the position of the 

volcano and the position of the highest column values. NB This calculation requires 

knowledge of the plume height, the accuracy of the wind direction is entirely depending on 

the estimation of the plume height.  
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Figure 49. The setup-inspection dialog. Here it is possible to see the position and direction of the scanning 

instrument on a map and look at the results from a scan. 

6.4 Post-processing wind speed and direction 
 

If a connected instrument has performed a measurement of the wind-speed using the dual-

beam technique, the resulting wind-speed will be calculated in real-time when the 

measurement is downloaded and evaluated. This can also be done in off-line mode from an 

already downloaded scan through the ‘Post Wind speed analysis’ – dialog.  
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Figure 50. The Offline wind speed analysis dialog. In this dialog it is possible to perform calculations of 

wind speed from measured dual-beam time series. 
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6.5 Data Browser Dialog 
The Data Browser dialog, accessible from the menu in the main window through; “Analysis” 

→ “View Measured Data” and lets the user browse through the measured data of one day 

while inspecting the properties of each scan.  

To view evaluated data, open an Evaluation log-file by choosing “Data Source” → 

“Evaluation Log” from the menu in the Data Browser dialog. The evaluation log is then 

opened, and the first scan is shown in the top graph. The left-hand side of the screen contains 

several of the parameters of the measurement which allows for easy inspection of the changes 

of these parameters during the day. The lower graph shows the evolution of the calculated 

flux of the measurements found in the opened evaluation-log.  

 

By pressing the left and right arrow buttons in the top part of the dialog, the dialog moves to 

previous or next scan in the evaluation log file.  

 

 

 

Figure 51. In the data browser dialog it is possible to step through the scans found in one EvaluationLog 

file and to see the information about the scans and a graphic representation of the calculated fluxes. 
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7.  Advanced file handling options 
 

The program contains a small set of utilities designed to make it easier to analyse the results 

of the programs real-time analysis. Among these is the possibility to import spectra from other 

file-formats and to export spectra to other file formats.  

 

Since the spectrum file format that the NOVAC-project use (pak-file format) is capable to 

contain several spectra in one file, there is also a small function to merge .pak-files together or 

to split the files in one pak-file into several. 

 

 

Figure 52. The file-handling functions are accessed from the File menu in the main window. 

7.1 Importing files 
 

From the import-dialog, it is possible to convert spectral files from older file-formats to the 

NOVAC-projects spectral file format, pak. Currently only STD-files generated by the 

program ScanDOAS made by Chalmers University of Technology can be read-in.  

 

By pressing the ‘Browse’ button, the program brings up a dialog which lets the user choose a 

number of spectral files to import. In the case for files generated by ScanDOAS, it is 

important that only full scans are selected. 

 

Under the ‘Generation’ group the user can specify, for spectral-files generated by ScanDOAS 

how many spectra make up one scan. This is necessary since this information is not specified 

in the spectrum files.   

 

Under the ‘Additional information’ group, the user can supply further information which is 

not given in the spectrum file but should be included in the pak-file. Most important is the 

scan angles for the different spectra in the scan, since this is necessary if one wishes to use the 

scan for flux-calculations. 

 

Under the ‘Output Directory’ group, the user can type in one directory where the resulting 

pak-files will be put. The program will generate one pak-file for each scan. It is important that 

the user has write access to the supplied output directory. 

 

The importing is performed when the user presses the ‘Import’ button in the lower part of the 

screen. If the ‘Ok’ or ‘Cancel’ buttons are pressed, the dialog will be closed, and nothing will 

be done. 
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Figure 53. The import dialog which can be found under the File menu in the main window. 

 

7.2 Exporting files 
 

7.2.1 Exporting spectra 

 

From the Export-spectra dialog it is possible to select one or more pak-files and to export 

them to another spectral file format, which can be read by some other program. Currently only 

STD-files can be written. 

 

The pak-files to be exported are selected by pressing the ‘Browse’ – button in the ‘.pak – 

file(s)’ group.  

 

The directory where to put the exported spectral files can be given by pressing the ‘Browse’ 

button in the ‘Export to:’ group or by directly typing in a directory name in the empty field in 

the ‘Export to’ group. In the supplied directory, one sub-directory will be created for each 

pak-file that is selected. 

 

The exporting is done when the user presses the ‘Export’ button. To close without performing 

any export press the ‘Ok’ or ‘Cancel’ buttons.  
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Figure 54. The export spectra dialog, which can be found under the File menu in the main window. 

 

5.2.2 Exporting Evaluation logs 

For back-wards compatibility, it is also possible to convert the evaluation-logs that are 

generated when the program is running, or the Re-Evaluation logs generated by the spectral 

re-evaluation routine, to a file format which is readable by ScanDOAS. 

 

Supply an evaluation log to export by pressing the ‘Browse’ button in the ‘Evaluation Log’ 

group. 

 

Supply a filename for the generated ScanDOAS-log by pressing the ‘Browse’ button in the 

‘Save As’ group. 

 

The export will be performed when the user presses the ‘Export’ button. To close without 

exporting anything, press the ‘Ok’ or ‘Cancel’- buttons. 

 

 

Figure 55. The export Evaluation-log dialog, which can be found under the File menu in the main window. 
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5.3 Checking pak-files 
In the Pak-file inspector dialog (found under ‘File’→’Check pak file’ in the main menu) the 

contents of one compressed spectrum file can be inspected. No modifications to the spectrum 

file can be made. 

To get a closer look at the spectrum, the spectrum view can be zoomed by moving the mouse 

cursor with the left mouse button pressed. To restore the view to the original scale, click once 

with the right mouse button. 

 

 

Figure 56. The pak-file inspector dialog shows the contents of one compressed spectrum file (.pak) 

 

5.4 Merging/Splitting pak-files 
 

5.4.1 Splitting pak-files into scans  

 

If a pak-file has been downloaded from the instrument manually (not by the running program) 

or if a pak-file has been uploaded to an FTP-server by the instrument (not by the running 

program) then the pak-file might not have been divided into separate scans. It is then 

necessary to separate the pak-file before it can be used in the Re-Evaluation routine.  

 

To do this open the Split/Merge dialog which can be found under ‘File->Split/Merge pak-

file(s)’ in the main window and choose the ‘Split pakfile into scans’-page.  
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The pak-files to be split can be selected by pressing the ‘Browse’ button in the ‘Pak File(s) to 

split into scans’ group. 

 

The directory, where to put the generated scan-files can be supplied by pressing the ‘Browse’ 

button in the ‘Output Directory’ – group or by typing in a directory-name in the empty space 

in the ‘Output Directory’ – group. A subdirectory will be generated in the output directory 

named ‘Scans’ which will contain the generated pak-files. 

 

The Splitting is started by pressing the ‘Split’ button. To close the dialog without splitting 

any files, press the ‘Ok’ or ‘Cancel’ buttons in the bottom part of the dialog. 

 

 

Figure 57. The 'split pak-files into scans' dialog, which is access from the File-menu in the main window. 

Through this dialog the user can select one or more pak-files and split them into separate scans. 

 

5.4.2 Merging pak-files  

Several .pak-files can be combined into one larger pak-file by using the Merge Pak Files page 

in the Split/Merge dialog. First select the pak-files that should be merged by pressing the 

upper most ‘Browse’ button, then select the directory where the merged file by either typing 

in the directory in the empty box or by pressing the second ‘Browse’ button. When the files 

have been selected and an appropriate output directory has been selected the button ‘Merge’ 

will be appear and pressing it will start the merging process. 

 

There are some options for how to do the merging. The options found in the group ‘Sorting’ 

determine how the pak-files should be sorted. The current options are to sort the files in 

ascending or descending order with respect to the original file name. The option found under 

‘Options’ specified how the pak-files should be merged. The first option (which is the default) 

is to simply put the spectra one after the other in the same file. The second option is to 

spectrally merge the files, this only works if pak-files containing scans with the same number 
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of spectra are selected. In this case the spectrum number 1 in the first pak-file will be 

spectrally added with spectrum number 1 in the second pak-file etc. The number of spectra 

that will be added together into one is typed into the empty white box just after the second 

radio-button. 

 

 

Figure 58.  The ‘merge pak-files’ dialog, which is access from the File-menu in the main window. Through 

this dialog the user can select several pak-files to merge together into one pak-file. 

 

5.5 Create References 
 

Users many create reference files from the File->Create References menu option.  This opens 

the below dialog.  Select the Slit Function, Wavelength Calibration, Input Cross Section, and 

Output files.  Determine conversion method (None or Vacuum to Air) and whether to apply 

High Pass Filter option.  Finally, click on ‘Run Convolution’. 
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Figure 59  Create Reference dialog 

 

8.  Upgrading and Troubleshooting the MOXA 

or SD2000 spectrometer 
 

In this section, several advanced techniques for upgrading the software on the embedded PC 

and troubleshooting the instrument are given. These techniques are given for reference, but 

they should only be attempted unless necessary or as a last resort. Using these 

techniques can render the instrument completely useless if something goes wrong. 

 

8.1 Upgrading kongo 
 

Currently the latest kongo version is 130614.tar. In case that an upgraded is needed, the 

installation file should be copied in the /home directory of the MOXA. The installing 

procedure is as follow: 

 

1- Using a FTP client, download in the MOXA the installation file into the location 

/home/install130614.tar (FTP-binary transfer mode is required). 

2- By using the HyperTerminal, Telnet or PuTTY, change the working directory to the 

location /home. This can be done simply by using the command cd /home/ 

3- Stop the programs that are running in the background - kongo and runsh - by the 

following commands: 

killall kongo 

killall runsh 
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4- Uncompress the installation file by using the command tar -xvf install130614.tar. This 

creates a new directory where all the installing files will be copied: /home/install/ 

5- Change the working directory to the newly created installing directory by using the 

command cd /home/install 

6- Execute the installing program by typing the command ./runme.bat 

7- After the installation is completed (it may take up to 1 minute), and the prompt (#) is 

back, reboot the MOXA. 

 

 

8.2 Installation of NOVAC program (kongo) on a newly 
formatted MOXA computer. 
 

If the MOXA computer was reset to factory settings and/or formatted, then the NOVAC 

program (kongo.exe and other files) needs to be reloaded on the computer. Below are step-by-

step instructions on how this is done. Note that formatting / reinstalling should only be 

done as a last resort if the MOXA is not functioning properly. 

 

After resetting the MOXA to the factory settings, before proceeding to reinstall the program 

kongo a few things should be considered: 

 

- The IP numbers are the factory default: 

Eth1 192.168.3.127 Mask:255.255.255.0 

Eth2: 192.168.3.127 Mask:255.255.255.0 

 

- Telnet and FTP have the following settings: 

User: root 

Password: root 

 

By FTP, using any of the default Ethernet ports and network/password settings, transfer the 

compressed installation file as follows: /home/install1301614.tar and continue with the steps 

below. 

 

For additional questions see: 
http://www.moxa.com/doc/man/UC-7112-LX_Plus_7112-LX_7110-LX_HW_Users_Manual_v5.pdf 
 

1. Open the MOXA computer and insert a 2GB SecureDigital card. 2 screws need to be 

removed. Put on the cover again and put back the two screws. 

 

2. Connect all the cables from the Manne-box to the MOXA-computer. 

 

3. Give power to the system. 

 

4. Take the newest install_xxyyzz.tar file (currently install130614.tar) and transfer that to 

directory /home in the MOXA box. This can best be done with ftp. 

 

5. Connect to the MOXA using PuTTY or similar program (see section 3). 

 

6. Enter into the /home directory with “cd /home”. 
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7. Unpack the tar file with “tar –xvf installxxyyzz.tar. 

 

8. A directory called install will be created. “Enter into that directory with “cd install”. 

 

9. Start the installation by entering “./runme.bat”. This will start the script that’s makes 

all the installation. After it has finished enter “reboot” to reboot the MOXA computer. 

 

10. The IP address of the MOXA will now be different. It will be set to the NOVAC 

default. This means that the MOXA will now be accessible at 10.0.0.90 on LAN2 (see 

section 3.2 for details. 

 

11. When starting up the kongo program will start executing with a test cfg.txt file 

configured for using 2 motors. Turn on log-printing by entering “showlog”. 

 

12. Make sure that the first motor is homing and stops homing when reaching the 

reference switch. 

 

13. Make sure that the second motor is homing and stops homing when reaching the 

reference switch. 

 

14. The GPS should be placed where reception is possible. When you see in the log-

printing that the system has achieved GPS-time and date then enter “hwclock –s” This 

will set the internal battery-powered real-time clock in the MOXA box to the received 

GPS-time. 

 

15. Finished 

 

 

8.3. Formatting the MOXA to the factory settings 
 

If for some reason the system is corrupted may be necessary to reboot the MOXA to the 

default factory settings. Notice that you need to backup or have available a copy of the 

installation file install130614.tar. After the system is formatted, all the configurations 

files will be deleted including the network settings. The whole procedure requires that the 

MOXA is connected by a HyperTerminal and a FTP client. 

 

1- Reboot the system simply by using the command reboot. 

2- Immediately, using a clip or a solid wire press the formatting button as shown in the 

figure below and keep it pressed until the whole process is completed.  
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The HyperTerminal will show you the following messages: 

 

INIT: Switching to runlevel: 6 

root@Moxa:/# Stopping portmap daemon: 

Stopping internet superserver: inetd. 

Sending all processes the TERM signal... done. 

Sending all processes the KILL signal... root@Moxa:/# done. 

Stopping web server: apache. 

Stopping snmpd 

Rebooting... Restarting system. 

Starting to reboot ... 

 

3- Still keeping pressed the formatting button, MOXA will beep for 10 seconds before 

the formatting is completed. In addition to the sound, you will be able to see in 

HyperTerminal the counting of seconds: 

 

Press <DEL> FOR SYSTEM RECOVERY 

0,1,2,3 ……..10 

 

Before the 10 seconds counting is completed this is your last chance to suspend the 

procedure 

 

4- The following messages will indicate that the procedure is complete: 

 

Format User Disk... 

Erase Flash 0x80a00000-0x81000000 and Length = 0x00600000 bytes 

Erase Flash 0x80a00000-0x80a20000 ..OK 

Erase Flash 0x80a20000-0x80a40000 ..OK 

Erase Flash 0x80a40000-0x80a60000 ..OK 

Erase Flash 0x80a60000-0x80a80000 ..OK 

 

5- Then you can release the button and wait for a few seconds until the whole memory is 

erased. The formatting is completed when you finally get the system’s default prompt: 

 

root@Moxa:/# 
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8.4. Setting the default baud rate of the SD2000 
spectrometer 
 

In order for the MOXA computer to be able to communicate with the Ocean Optics 

spectrometer (either SD2000 or S2000), the default baud rate of the spectrometer must be set 

to 115,200. The default baud rate is the baud rate that the spectrometer uses when the power is 

first turned on. When spectrometers are received from Ocean Optics, their default baud rate is 

often set to 9600. In this condition, the MOXA will not be able to communicate with the 

spectrometer.  

 

To change the default baud rate, connect the spectrometer to a laptop computer with a serial 

cable (not a null modem cable). Connect power to the spectrometer via the separate power 

port. Once the green light has turned on on the spectrometer, open PUTTY or a similar 

program and connect to the spectrometer using the settings  

 

Baud rate: 9600 (unless it has already been changed) 

Data bits: 8 

Stop bits: 1 

Parity: None 

Flow control: None 

 

Type aA to enter ASCII mode 

 

Check that you are in ASCII mode by performing a scan. Enter S<Enter>. This should return 

2048 numbers that are clearly legible if you are in ASCII mode. 

 

To change the power-up baud rate: 

Type x43<Enter> 

Type Baud 6<Enter> 

 

To check if the parameter change was successful, you can query the parameter by entering 

?x43<Enter>. This should return ‘Baud 6’. 

 

Cycle the power on the device. It should now communicate at 115,200 baud. 

 

Note that if you want to use a different baud rate for any reason, the following table lists the 

possible options. But the MOXA only communicates at 115,200 baud. 

 

Baud 0 = 1200 

Baud 1 = 2400 

Baud 2 = 9600 

Baud 3 = 19,200 

Baud 4 = 38,400 

Baud 5 = 57,600 

Baud 6 = 115,200 
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8.5. Instrument configuration not recognized 
 

The measurement configuration for each instrument is stored in the file cfg.txt on the 

embedded computer. This file has a very specific format which is described in section 3.2.4 of 

this manual. If the file format is compromised in some way, the instrument may not be able to 

recognize the cfg.txt file as a configuration file, and a default configuration will be assumed. 

 

Unfortunately, this default configuration will generally not be useful. Upon reboot, the 

scanner will move to the end position, then rotate to a fixed direction and measure a single 

spectrum called 'scan'. This single acquisition will be repeated, each time starting a new *.pak 

file on the SD card. In other words, each saved *.pak file will only contain a single 'scan' 

spectrum. 

 

Also, the DELAY parameter will default to 0, which may make the scanner spin at a very 

high speed, or since the delay is meant to ensure proper stepping of the motor, it may mean 

that the scanner does not move at all. If the scanner is spinning very quickly despite the 

fact that the user has set the DELAY parameter to a reasonable value (e.g. 500), then 

there is likely a problem with the formatting of the cfg.txt file. 

 

One common yet very subtle problem with the cfg.txt file formatting is improper use of 

'end of line' characters. If the wrong end of line characters are used, the text file may 

seem completely fine when opened in a text editor on a computer, but may still not be 

recognized by the computer embedded in the NOVAC instrument.  

 

The embedded computer will recognize the cfg.txt file if each line of the text file ends with 

both a 'carriage return' (CR) and 'line feed' (LF) character. The text file may not work if only 

one of these characters is present. The way to check this is to open the cfg.txt file in a text 

editor and make the special characters visible. One editor capable of this is the freely 

available Notepad++. In this software, clicking on the 'Show All Characters' button in the 

quick access bar at the top will make special characters visible. The end of line convention 

can then be set using the menu. Selecting Edit -> EOL Conversion -> Windows will ensure 

that each line ends in CR LF. After reformatting the text file, overwrite the existing cfg.txt on 

the embedded computer. Hopefully, the instrument will now recognize the configuration. 

  

Appendix A: Previous versions of the NOVAC 

instrument 
 

Prior to the current version of the NOVAC instrument which uses a Moxa embedded PC, two 

other version were used. The first version (version 1) used a Beck PC. The second version 

(version 2) used an Axis PC. In this appendix, instructions that apply to these older versions 

of the NOVAC instrument are collected. Though these older versions are no longer 

distributed, this information can be useful for troubleshooting older versions of the instrument 

that are still running in the field in some places. 

 



   NOVAC Scanning DOAS Manual 

 

 81 

Version 1 (Beck) electronics 

Technical information 

 
 

The version 1 control system is based on the BECK-IPC SC12-LC chip. This is an embedded 

computer that can run programs in a similar manner as MS-DOS programs. In one single chip, 

it consists of an 80186 processor running on 20 MHz, 512 Kbytes RAM, 512 Kbytes of 

FLASH-EEPROM containing an operating system and the running programs. It also contains 

a 10Mbit/s Ethernet-network interface and two RS232 connections.  

 

The embedded operating system is similar to MS-DOS but also has multitasking capabilities, 

a web-server, an FTP-server and built in commands for using the network-interface. 

Approximately 200 Kb of the FLASH-EEPROM is occupied by the operating system, leaving 

312 Kbytes for simulating a disk-drive where running programs can be stored and collected 

data saved. 

 

For more information, check the producer’s web site: http://www.beck-ipc.com . 

 

 

File Structure on Remote PC Version 1 (Beck) 

There are two disks in the remote PC. Disk A stores system files, controlling programs, and 

the configuration file. Disk B stores the spectra files.  

 
 

http://www.beck-ipc.com/
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Figure 60: Remote PC File List 

 

Chip.ini is a system configuration file which configures FTP server, WEB server, TELNET 

and serial communication settings. The detailed will be introduced later in this chapter. 

 

Cfg.txt is the configuration file for spectra collecting. The details will be introduced later in 

this chapter. 

 

Kongo.exe is the program which controls the whole Scanning DOAS. It downloads data from 

the spectrometer and saves spectra into Work.pak.  

 

Work.pak will be converted into Upload.pak when a full scan is done or it gets one spectrum, 

which depends on the setting in the configuration file Cfg.txt.  

 

Upload.pak is a compressed spectra file which is ready to be transferred to our local 

computer. Upon completion of a new scan, this will be renamed to the lowest available 

number in the series U001.pak, U002.pak, U003.pak, … 

 

U001.pak, U002.pak, … these are compressed spectrum files ready to be transferred to our 

local computer. 

 

ZTRANS.exe and TX.exe are data transfer tools. They oversee uploading and downloading 

data. 

 

Status.dat stores the scanner running status messages. Its size remains at 1Kbytes. 

 

Setstime.exe is a program to set the remote PC time. 

 

Network configuration 

 

The file ‘Chip.ini’ is stored on the internal disk A in the version 1 electronics. Notice that 

chip.ini is only available in the version 1 electronics. The file defines the information of FTP 

server, WEB server, TELNET service running on the remote PC and serial communication 

settings. 

It can be displayed by entering type chip.ini in HyperTerminal. The file looks like this: 
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[FTP] 
DRIVE0=1 
USER0=novac 
PASSWORD0=1225 
USER1=administrator 
PASSWORD1=1225 
DRIVE1=0 
TIMEOUT=65535 
 
[WEB] 
ENABLE=1 
DRIVE=1 
WEBSERVERSTACK=10240 
SECURE=1 
 
MAINPAGE=main.htm 
TEMPPATH=B:\ 
 
[TELNET] 
USER0=novac 
PASSWORD0=1225 
USER1=administrator 
PASSWORD1=1225 
 
[SERIAL] 
EXT_BAUD=9600 
EXT_RECVQUEUE=10240 
EXT_SENDQUEUE=10240 
COM_BAUD=115200 
COM_RECVQUEUE=10240 
COM_SENDQUEUE=10240 
 
[IP] 
NETMASK=255.255.0.0 
GATEWAY=129.16.1.4 
ADDRESS=129.16.35.207 
DHCP=0 

 

The baud-rate used for communicating with the spectrometer is set by the EXT_BAUD 

parameter. Make sure this parameter matches the baud-rate for your spectrometer. The default 

baud-rate for OceanOptics spectrometers is 9600 but can be changed with the  

x43 command. With the ADC-1000 and 2000 spectrometers baud-rates up to 115200 can be 

used which greatly reduces the time for transmission. The baud-rate for communicating with 

your PC is set by the COM_BAUD parameter. 

If connecting by Ethernet, the parameters are given after the [IP] tag. By default, WEB, FTP, 

and TELNET is enabled and the passwords are given in the chip.ini file. For more 

information, see Appendix II. 

 

 

Using HyperTerminal to Diagnose Beck Remote PC 

 

1. Configure HyperTerminal 
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Set correct baudrate for the COM port which is connecting the Scanning DOAS. If radio 

modems are used for the communication, then the COM port is the port which connects the 

radio modem and the bits per second is the baud rate that the radio modem is using.  Other 

settings should be like the figure below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 61. Port Settings of HyperTerminal 

 

2. Start Command Mode 

 

The embedded PC in the PCB in the Scanning DOAS has three modes – user, shell and both 

(see Figure 10 below). When you communicate with the Scanning DOAS by HyperTerminal, 

one of the above three modes is used. To switch between the three modes, press “Ctrl + F”. 

 

Shell mode – It is the command mode. The sign is “Stdio: Shell”. In this mode, you can type 

in commands and browse files in the embedded PC.  

User mode – It is working status mode. The sign is “Stdio: User”. In this mode, working 

messages are shown. You cannot type in commands or browse files.  

Both mode – It has functions of both shell mode and user mode. The sign is “Stdio: Both”. In 

this mode, you can both type in commands and view the working messages. When it is 

working messages, you can type return on the keyboard to enter command mode. When you 

stop typing in commands, it automatically switches to working messages. 
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Figure 624 Three Modes of Remote PC 

 

 

3. Working Messages 

 

In “Stdio: User” mode, the working messages are shown. If you cannot see any updated 

messages, the remote PC might have stopped working. Then one solution is to switch to 

“Stdio: Shell” mode and type “reboot” to reboot the remote PC. 

 

 

 

4. Commands 

Some of commands of the single-chip PC are similar to DOS commands. 

 

(1) Ctrl+F 

Switch among the three modes – “Stdio: User”, “Stdio: Shell”, and “Stdio: Both”. Both 

“Shell” and “Both” modes accept commands input. In “User” mode, you can watch the 

running status of the Scanning DOAS. 

 

(2) A: B: 

Type “A:” and return. You can switch from disk B:\> to disk A:\>. 

Type “B:” and return. You can switch from disk A:\> to disk B:\>. 

 

(3) Kongo 

This command starts Kongo.exe program. While kongo.exe is running, this command won’t 

start another kongo program due to lack of memory. The command is: 

 

kongo 
 

(4) Dir 

Browse the files in one disk. The command is: 

 

dir 

 

(5) Type 

View content of a text file. If you want to read the content of the cfg.txt. Use the following 

command: 
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type cfg.txt 
 

(6) Del 

Delete one file. For example, if you want to delete cfg.txt from disk B, use the following 

command: 

 

del cfg.txt 
 

(7) Reboot 

It reboots the remote PC. The command is as follows: 

 

reboot 
 
(8) Ztrans commands 

 

Ztrans commands are for downloading and uploading files between the local PC and the 

remote PC. 

 

(a) Download a file 

A file can be downloaded to your PC by sending the following command from 

HyperTerminal. For example, we are going to download cfg.txt from the remote PC. In 

HyperTerminal we type the following commands with enter key. 

 

ztrans com s cfg.txt 115200  
 

This will start zmodem-download in HyperTerminal. The file will be stored in the location on 

your PC as given by the Transfer->Receive File menu in HyperTerminal.  

 

(b) Upload a file 

 

To upload a file, first type in the following command with enter key. 

 

ztrans com r 115200  
 

 

After sending that, choose the menu  

Transfer->Send file.  

 

 

 

 

 

 

Then choose the cfg.txt you want to upload and choose Zmodem transfer in the dialog.  
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Figure 15 Choose File to Download 

 

During this procedure, the HyperTerminal screen will show the following strings. It means 

that the remote PC is ready and waiting for the file. 

 

 

Figure 63 Waiting Messages during Downloading 

 

Note: When upload a file, make sure that there is not the file with same name in the remote 

PC. If there is, delete that file then upload. 

 

 

 

5. Trouble Shooting with HyperTerminal 

 

(1) Is Scanning DOAS is running? 

Start HyperTerminal. Switch to “Stdio: User” mode. If the messages are updating, the 

Scanning DOAS is running. If it seems not running, you can type “kongo” to start kongo.exe 

program. 

 

(2) How can I update one file in the remote PC? 

Start HyperTerminal. First, go to disk B. Delete the existing old file. Then use Ztrans 

command to upload file. 

 

 

 

Use of the File Transfer Dialog in the NOVAC software (only for Beck PC 
instruments (version 1)) 

 

When the routine file transferring is not running, you can manually transfer files. Click menu 

“Configuration -> File Transfer” to directly transfer file between your computer and the 

scanner. 
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Figure 10 File Transfer Dialog 

 

Show File List 

Click one scanner in the list on the left of the dialog. The file list will be shown. If it is not 

successful, click it one more time. 
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Download File 

 

 

Figure 64. Popup Menu in File List 

 

Right-click one file in the “File List”, a menu will pop 

up. Click “Download” to download the file that you have 

selected. Then a “Save As” dialog will ask for the 

directory to save the file. Choose the correct directory 

that you want to save the file. Then the downloading 

begins. The status will be shown in the “Status Message” 

box in both the main window and this dialog. 

 

Download Folder 

 

Figure 65. Popup Menu in File List 

Right-click one folder in the “File List”, a menu will 

pop up. Click “Download Folder” to download the 

folder that you have selected and all files in it.  

Then a “Save As” dialog will ask for the directory 

where to save the folder. Choose the correct directory 

that you want to save the folder. Then the downloading 

begins. The status will be shown in the “Status 

Message” box in both the main window and this dialog. 
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View a Text File Content 

This function is to read the content of the text files (files with suffix as “.txt” and “.ini”) in the 

scanner.  

Right-click one file in the “File List”, a menu will pop up. Click “View File” to download and 

see the file content that you have selected. The file content will be shown in the big edit box 

on the right of the dialog. Then the downloading begins. The status will be shown in the 

“Status Message” box in both the main window and this dialog.  

The file content is editable. You can click  to edit it and replace the 

original file in the remote scanner. 

 

View the content of a Folder 

 

Figure 66. Popup Menu in File List 

Right-click one folder in the “File List”, a menu will 

pop up. Click “Expand Folder” to expand the file list 

with the files inside the marked folder. After some 

seconds (time depends on the data speed) the file list 

will update and show files inside the marked folder. 

 

Delete a File 

Right-click one file in the “File List”, a menu will pop up. Click “Delete” to delete the file 

that you have selected. Then a dialog will whether you want to delete it. Choose “Yes” to 

delete it.  

Note: You cannot undo this function. 

 

Upload a File 

Click “Browse” button to select a file in your computer. Then choose the disk where you want 

to upload the file to. 

 

 
 

Then click  button to upload the file. 
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Version 2 (Axis) electronics 

Technical information 

 

 
 

The version 2 control system is based on an Axis 89 Device Server. 

 

The device server has two Ethernet – ports (one 10 MBit/s and one 100 MBit/s), three serial 

(RS232) ports and one USB – port (v1.1). The processor is a 32 bit RISC processor. The 

operating system and software are stored a built in 32 MB flash card, of which the operating 

system uses 4 MB, leaving 28 MB for software. Collected data is stored on an inserted SD-

card using FAT32. Power supply accepted is 8 – 20 V DC, with a typical power consumption 

of 2 W. The operating system in the Device Server is a Linux system with added web-server, 

FTP-server.  

 

For more information, check the producer’s web site: http://www.axis.se 

 

 

File Structure on Remote PC Version 2 (Axis) 

There are two important folders in the Remote PC: 

 

/mnt/flash/ in this folder is the controlling program stored (kongo), the software for data 

transfer (tx) and the configuration file(s) (cfg.txt, cfgonce.txt or cfgstrat.txt). 

 

/mnt/flash/novac/ in this folder are the collected spectrum files stored. 

 

 

The important files in these locations are: 

 

Cfg.txt is the configuration file for spectra collecting. The details will be introduced later in 

this chapter. 

 

Kongo is the program which controls the whole Scanning DOAS. It downloads data from the 

spectrometer and creates the file upload.pak upon the completion of one full scan. Notice that 

there is no work.pak in the version 2 of the electronics as all the information in the scan on 

http://www.axis.se/
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which kongo is working is stored the RAM memory and written to disk upon the completion 

of the scan. 

 

Upload.pak is a compressed spectra file which is ready to be transferred to our local 

computer.  

 

U001.pak, U002.pak, … these are compressed spectrum files ready to be transferred to our 

local computer. 

 

TX  is a data transfer tool. It is in charge of uploading and downloading data. 

 

 

 

 

 



   NOVAC Scanning DOAS Manual 

 

 93 

Using HyperTerminal to Diagnose Axis Remote PC (version 2) 

1. Configure HyperTerminal 

 

Set correct baudrate for the COM port which is connecting the Scanning DOAS. If radio 

modems are used for the communication, then the COM port is the port which connects the 

radio modem and the bits per second is the baud rate that the radio modem is using.  Other 

settings should be like the figure below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 67.  Port Settings of HyperTerminal 

 

2. Show Software Output 

To show the output of the Kongo – program the commands showlog and nolog are used. 

 

showlog: giving this command will make the remote PC show the output from the kongo 

program for some minutes. It is still possible to type commands. 

 

nolog:  giving this command will stop showing the output from the kongo program. 

 

3. Working Messages 

After giving the command showlog, the working messages are shown. If you cannot see any 

updated messages, the remote PC might have stopped working. Then one solution is to reboot 

the remote PC. 

 

4. Location of software and data 

All data generated by kongo are stored in the directory /mnt/flash/novac/. 

The software ‘kongo’, the configuration files‘cfg.txt’ are stored on /mnt/flash/ 
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5. Commands 

The commands to the remote PC are similar to Linux commands. 

 

(1) ls 

Shows the files and directories in the current directory. A more extensive list, including file 

sizes and access rights can be obtained by adding the flag ‘-l’. The command is 

 
ls -l 

 

(2) more 

This built-in program can be used to view the content of a file. E.g. if you want to read the 

content of the file cfg.txt the command to use is the following (assuming that cfg.txt can be 

found in the current directory): 

 
more cfg.txt 

 

(3) rm 

This command removes a file found in the current directory. E.g. 

 
rm U001.pak 

 

(4) reboot 

Reboots the remote PC. 

 

(5) cd 

Change the current working directory. This can be a absolute path or a relative path. E.g. 

changing to the data-storage directory: 

 
cd /mnt/flash/novac/ 

 

Changing to the parent directory of the current working directory by the command (notice the 

space); 

 
Cd .. 
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Appendix B: Special Measurement Modes 
 

The performed measurements will, by the NovacProgram, be categorized in any of the 

following measurement modes. Many of these modes will not be used in a typical 

measurement setup but are rather for special research purposes only. 

 

Mode Description 

Flux Normal measurement mode. Full scan from horizon to horizon 

with variable or fixed exposure-time. 

Wind speed Measurement of plume-speed using the dual-beam technique. 

Contains at least 50 measurements in the same direction and 

performed at a time when the Solar Zenith Angle is less than 75°. 

Composition Measurement with a few spectra collected inside the plume (with a 

high number of co-adds) and variable exposure-time throughout 

the scan. Has no more than 15 spectra and at least one of them has 

the name ‘comp’ 

Stratosphere Measurement of stratospheric compounds. Contains at least 3 

measurements in the zenith and performed at a time when the 

Solar Zenith Angle is more than or equal to 75°. 

Troposphere -- 

Max-DOAS -- 

Direct-sun Measurement aimed directly at the sun. Contains at least 5 spectra 

with the exact name ‘direct_sun’ 

Lunar Measurement aimed directly at the moon. Contains at least 5 

spectra with the exact name ‘lunar’ 

 

 

In a flux-measurement, all spectra will be used to calculate the flux except for spectra which 

have names starting with any of the following (case insensitive); 

• Sky 

• Dark 

• Offset 

• Sun_ 

• Moon_ 

• Strat 

• Trop 

• Maxdoas 

• Wind 

• Special 
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Appendix C: Configuring Point-to-Multipoint 

FreeWave Radio modems 
 

This part is about how to configure radio modems when multiple remote scanners are 

applied via a FreeWave Radio Network.  

Basically the radio modem at observatory works as a master. The radio modems 

connecting to the remote scanners work as slaves. According to the geographical 

environment, choose whether and where repeaters are used. Because in this network 

structure one radio modem controls all other radio modems, this network is call point-to-

multipoint network. 

 

 

 

1. Configuration of Master to Multiple Slaves through 
Repeater 
 

In this network configuration FreeWave transceivers can utilize up to 4 Repeaters. However, 

there is no limitation on baud rate setting when repeater is used. When a Repeater is used, the 

RF throughput is cut in half. When there is no repeater used, the sustained data throughput is 

115.2 kbps. When repeaters are used, the sustained data throughput is 57.6 kbps.  

 

1.1 Master to Multiple Slaves through One Repeater 

 

For example, we have four radio modems with radio ID 922-3083, 922-2973, 922-2965 and 

922-2930. We will have 2 slaves, one repeater and one master in this network. 

 

 
The configurations are as this table: 

 

Radio ID Modem Mode Call book 

Entry 

Number 

Repeater1 Repeater2 

922-3083 Point-to-Point Master/Slave 

Switchable 

922-2930 

922-2973 

 

922-2930 

 

Master 

922-3083 

Slave 922-2965 

Repeater 

922-2930 

Slave 922-2973 

Steps to configure the FreeWave radio modem  

• Connect 6V~ 30V power to the radio modem.  

• Connect a RS232 serial cable to the COM port on your PC and the radio 
modem.  

• Start HyperTerminal. Set data rate to 19,200, data bits - 8, Parity- none, 
Stop bits – 1, Flow control – none. 

• On the back panel of the FreeWave press the Setup Button for 1 second. 
The three lamps will become solid green.  
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922-2965 922-2930 

922-2930 Point to Point Slave/Repeater 922-3083   

922-2973 Point to Point Slave 922-3083 922-2930  

922-2965 Point to Point Slave 922-3083 922-2930  

 

I. Configure FreeWave MASTER  

 

The master is working on at observatory site where NOVAC software resides. In the 

configuration interface in HyperTerminal, configure as follows: 

• Choose “(0) Set Operation Mode”. Set it to “Point-to-Point Master/Slave 

Switchable”. 

• Choose “(1) Set Baud Rate” Set correct baud rate that you will use in the network, 

for example 115200. 

• Choose “(2) Edit Call Book”. Input serial numbers of radio modems that this radio 

modem will connect to. The call book will look like: 

 

 
  

II. Configure Repeater 

 

• Choose “(0) Set Operation Mode”. Set it to “Point-to-Point Slave/Repeater”. 

• Choose “(1) Set Baud Rate” Set correct baud rate that you will use in the network, 

for example 115200. 

• Choose “(2) Edit Call Book”. Input only the serial number of the master radio 

modem. The call book will look like: 

 

 

 

 

 

 

 

 

 

 

 

 

Entry Number Repeater1 Repeater2  

(0) 922-2930 

(1) 922-2973  922-2930 

(2) 922-2965  922-2930      

(3) 000-0000      

(4) 000-0000      

(5) 000-0000      

(6) 000-0000      

(7) 000-0000      

(8) 000-0000     

(9) 000-0000 

Entry Number Repeater1 Repeater2  

(0) 922-3083 

(1) 000-0000     

(2) 000-0000     

(3) 000-0000      

(4) 000-0000      

(5) 000-0000      

(6) 000-0000      

(7) 000-0000      

(8) 000-0000     

(9) 000-0000 
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III. Configure Remote Stations 

 

The remote stations are configured as the following: 

 

• Choose “(0) Set Operation Mode”. Set it to “Point-to-Point Slave”. 

• Choose “(1) Set Baud Rate” Set correct baud rate that you will use in the network, 

for example 115200. 

• Choose “(2) Edit Call Book”. Input the serial number of the master radio modem as 

“Entry number”. Input the serial number of the repeater respectively. The call book 

will look like: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.2 Master to Multiple Slaves through Several Repeaters 

 

For example, we have 6 radio modems with radio ID 242-6789, 242-6790, 242-6788, 242-

6670, 242-6679 and 242-6675. We will have 2 slaves, 3 repeaters and one master in this 

network. Each of Repeater3, Slave1 and Slave2 is connected to one Scanning DOAS. 

 

 
The configurations of the modems are as this table: 

 

Radio ID Modem Mode 

242-6789 Point-to-Point Master/Slave Switchable 

242-6790 Point to Point Repeater 

242-6788 Point to Point Repeater 

242-6770 Point to Point Slave/Repeater 

242-6679 Point to Point Slave 

242-6675 Point to Point Slave 

Master 

242-6789 

Slave2 242-6675 

Repeater3 

242-6670 

Repeater1 

242-6790 

Repeater2 

242-6788 

Entry Number Repeater1 Repeater2  

(0) 922-3083  922-2930 

(1) 000-0000     

(2) 000-0000     

(3) 000-0000      

(4) 000-0000      

(5) 000-0000      

(6) 000-0000      

(7) 000-0000      

(8) 000-0000     

(9) 000-0000 

Slave1 242-6679 
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I. Configure FreeWave MASTER  

 

The master is working on at observatory site where NOVAC software resides. In the 

configuration interface in HyperTerminal, configure as follows: 

• Choose “(0) Set Operation Mode”. Set it to “Point-to-Point Master/Slave 

Switchable”. 

• Choose “(1) Set Baud Rate” Set correct baud rate that you will use in the network, 

for example 115200. 

• Choose “(2) Edit Call Book”. Input serial numbers of radio modems that this radio 

modem will connect to. The call book will look like: 

 

 
Entry 0 is the repeater1 (242-6790), which is directly linked with the master.  

Entry 1 is repeater2 (242-6788), which is linked with the master through repeater1 (242-

6790). 

Entry 2 is repeater3 (242-6670), which is linked with the master through repeater1(242-6790) 

and then repeater2 (242-6788). 

At Entry 3, slave1 (242-6679) uses 3 repeaters. The master calls slave1 through repeater1 

(242-6790), repeater2 (242-6788), and repeater3 (242-6670). There are only 2 positions for 

repeaters, so the row of entry 4 begins with 999-9999 to continue “Entry 3”. It is same for 

Entry 5. 

 

II. Configure Repeater1, Repeater2 

 

• Choose “(0) Set Operation Mode”. Set it to “Point-to-Point Repeater”. 

• Choose “(1) Set Baud Rate” Set correct baud rate that you will use in the network, 

for example 115200. 

• Choose “(2) Edit Call Book”.  

Repeater1 is directly connected to the master. So input only the serial number of the 

master radio modem. The call book will look like: 

 

 

 

 

 

 

 

Entry Number Repeater1 Repeater2  

(0)     242-6790 

(1)     242-6788      242-6790 

(2)     242-6670      242-6790     242-6788 

(3)     242-6679      242-6790     242-6788 

(4)     999-9999       242-6670 

(5)     242-6675       242-6790     242-6788 

(6)     999-9999       242-6670  

(7)     000-0000      

(8)     000-0000     

(9)     000-0000 

Entry Number Repeater1 Repeater2  

(0)     242-6789       

(1)     000-0000     

(2)     000-0000     

(3)     000-0000      

(4)     000-0000      

(5)     000-0000      

(6)     000-0000      

(7)     000-0000      

(8)     000-0000     

(9)     000-0000 



   NOVAC Scanning DOAS Manual 

 

 100 

 

 

 

 

Repeater2’s configuration is same in first two steps. Comparing with repeater1 it just 

has a different call book. It is connected to the master through repeater1. So for 

repeater2 the call book will look like: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

III. Configure Repeater3 

 

Repeater3 is connected with one Scanning DOAS instrument, so it is not a simple repeater. It 

uses a different mode than other repeaters. 

• Choose “(0) Set Operation Mode”. Set it to “Point-to-Point Slave/Repeater”. 

• Choose “(1) Set Baud Rate” Set correct baud rate that you will use in the network, 

for example 115200. 

• Choose “(2) Edit Call Book”. Input the serial numbers of the master and repeaters. It 

connects to the master (242-6789) through 242-6788 first, and then242-6790. So the 

call book will look like: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

IV. Configure Remote Stations 

 

A remote station is configured as the following steps using slave1 as example. 

 

• Choose “(0) Set Operation Mode”. Set it to “Point-to-Point Slave”. 

Entry Number Repeater1 Repeater2  

(0)     242-6789     242-6788        242-6790                                           

(1)     000-0000     

(2)     000-0000     

(3)     000-0000      

(4)     000-0000      

(5)     000-0000      

(6)     000-0000      

(7)     000-0000      

(8)     000-0000     

(9)     000-0000 

Entry Number Repeater1 Repeater2  

(0)     242-6789      242-6790 

(1)     000-0000     

(2)     000-0000     

(3)     000-0000      

(4)     000-0000      

(5)     000-0000      

(6)     000-0000      

(7)     000-0000      

(8)     000-0000     

(9)     000-0000 
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• Choose “(1) Set Baud Rate” Set correct baud rate that you will use in the network, 

for example 115200. 

• Choose “(2) Edit Call Book”. Input the serial number of the master radio modem as 

“Entry number”. Input the serial number of the repeater respectively. The slave1 calls 

the master (242-6789) through 242-6670, 242-6788, and then 242-6790. Because there 

are more than 2 repeaters, the second line continues the first line by put 999-9999 at 

the first position then the 3rd repeater. The call book will look like: 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Configuration of Master to Multiple Slaves without 
Repeater 
 

I. Configure FreeWave MASTER  

 

The master is working on at observatory site where NOVAC software resides. Since there is 

no repeater used, leave the repeater 1 and repeater 2 columns blank. In the configuration 

interface in HyperTerminal, configure as follows: 

• Choose “(0) Set Operation Mode”. Set it to “Point-to-Point Master/Slave 

Switchable”. 

• Choose “(1) Set Baud Rate” Set correct baud rate that you will use in the network, 

for example 115200. 

• Choose “(2) Edit Call Book”. Input serial numbers of radio modems that this radio 

modem will connect to. The call book will look like: 

 

 

Entry Number Repeater1 Repeater2  

(0) 922-2973 

(1) 922-2965   

(2) 000-0000    

(3) 000-0000      

(4) 000-0000      

(5) 000-0000      

(6) 000-0000      

(7) 000-0000      

(8) 000-0000     

(9) 000-0000 

Entry Number Repeater1 Repeater2  

(0)     242-6789      242-6670     242-6788 

(1)     999-9999      242-6790 

(2)     000-0000     

(3)     000-0000      

(4)     000-0000      

(5)     000-0000      

(6)     000-0000      

(7)     000-0000      

(8)     000-0000     

(9)     000-0000 
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II. Configure Remote Stations 

 

The remote stations are configured as the following: 

 

• Choose “(0) Set Operation Mode”. Set it to “Point-to-Point Slave”. 

• Choose “(1) Set Baud Rate” Set correct baud rate that you will use in the network, 

for example 115200. 

• Choose “(2) Edit Call Book”. Input the serial number of the master radio modem as 

“Entry number”. The call book will look like: 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Test Connection 
 

When all FreeWaves are in the above configuration, you will see only solid Red light on the 

left (CD) and Blinking Red on the right (CTS) on all radios, which means that the radio 

modems are not connected. 

 

To test whether your radios are configured correctly, you can use either the HyperTerminal to 

type the string ATD, at which time you should get an 'OK' from the Master Radio. Then 

carefully, for you will not see an 'echo' type ATDXXXXXXX where X is the 7 digit ID of the 

Repeater or a Remote Slave. Immediately, without hitting a C/R, the Master radio should 

display Green CD, as will the Repeater, and the Slave whose number you typed in. At the 

same time you will see, on your screen CONNECTED - if you are in fact connected to the 

Slave FreeWave. To test another link, disconnect this connection by click  in the 

HyperTerminal and then connect to another radio modem. 

 

The NOVAC program works same no matter how the point-to-multipoint network is 

configured, as long as the “radioID/callbook number” is filled in correctly. 

 

Entry Number Repeater1 Repeater2  

(0) 922-3083   

(1) 000-0000     

(2) 000-0000     

(3) 000-0000      

(4) 000-0000      

(5) 000-0000      

(6) 000-0000      

(7) 000-0000      

(8) 000-0000     

(9) 000-0000 
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Appendix D: Preparing the Ocean Optics 

MayaPro spectrometer for use in NOVAC 

instruments 

 
The Ocean Optics MayaPro spectrometer features an uncooled back-thinned CCD detector. 
These are more sensitive to ultraviolet light than the standard CCD sensors installed in most 
other Ocean Optics spectrometers. This makes the MayaPro an attractive choice particularly 
for high-latitude environments where ultraviolet light is limited. 
 
Using the MayaPro in a NOVAC instrument requires specialized firmware to be installed on 
the spectrometer. This firmware version enables the user to set the power-up baud rate of 
the spectrometer to 115,200, the speed at which the MOXA computer handles serial 
communication. Below is a description of how to configure a MayaPro for use in a NOVAC 
instrument. 
 
What you will need: 

• Ocean Optics MayaPro Spectrometer 
• Ocean Optics HR4-CBL-DB15 adapter cable 
• DC power female barrel connector, 1.3mm inside contact, 3.4mm outside contact 

(e.g. Kobiconn P/N 163-0309-EX available from Mouser Electronics) 
• Female DB9 (serial port) connector  
• USB cable 
• Serial cable 
• PuTTY or other serial console software (available for free at www.putty.org) 
• USBProgrammer software (available from the Software Downloads section of the 

Ocean Optics website) 
• HRFPGA.HEX (NOVAC configuration file for USBProgrammer) 
• MayaPro2000 v1031.iic (spectrometer FX/2 firmware) 
• MAYAPROv3000.xsvf (spectrometer FPGA firmware) 
• install180617.tar (installer for configuring the embedded PC in the NOVAC 

instrument) 

 
Step by step instructions: 
 
Install and configure USB Programmer 

• Install USBProgrammer on a computer. If using a desktop, beware that a power 
outage during firmware update could corrupt the spectrometer and render it 
unusable. Consider using a laptop that is either plugged in or has a charged, reliable 
battery to avoid this problem. IF USING A LAPTOP, DO NOT LET IT GO TO SLEEP 
DURING THE UPDATE PROCESS! 

• Rename the file in C:\Program Files\Ocean Optics\USBProgrammer\HRFPGA.hex to 
HRFPGA_OLD.hex 

http://www.putty.org/
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• Copy the NOVAC hex file HRFPGA.HEX into that same directory. 

Update the FX/2 firmware 

• Connect the MayaPro to the USB port. 
• Run the USB Programmer by selecting Start | Programs | Ocean Optics | USB 

Programmer |USB programmer.  This utility will display your Maya2000 Pro in the 
left hand pane. 

• Go to File | Unlock Features.   In the new little window type UNLOCKALL | click Ok 
• Go to File | Unlock Features.   In the new little window type UNLOCKFPGA | click Ok 
• Go to File | Unlock Features.   In the new little window type UNLOCKMFG | click Ok 
• Click on the Maya2000 Pro serial number to select it. Once you select the device, 

detailed information for that device is displayed in the right pane of the interface.  
• Press the 'Program FX/2' button (Not the Program FPGA button!) and select 

the MayaPro2000 v1031.iic file. 
• Programming begins immediately, and the estimated time for completion of the 

reprogramming process displays in the bottom status bar. DO NOT INTERRUPT the 
programming process for any reason!  If the programming process is interrupted, 
permanent corruption can occur in the device.  Programming the FX/2 will take about 
2 minutes. 

• Once the programming is complete, a pop up window will appear telling you to 
power down the spectrometer. Unplug the spectrometer from the computer. 

• Shut down the USB Programmer software. 
• Wait 10 seconds 

Update the FPGA firmware 

• Plug the spectrometer back into the USB port. 
• Restart USB Programmer 
• Go to File | Unlock Features.   In the new little window type UNLOCKALL | click Ok 
• Go to File | Unlock Features.   In the new little window type UNLOCKFPGA | click Ok 
• Go to File | Unlock Features.   In the new little window type UNLOCKMFG | click Ok 
• Click on the Maya2000 Pro serial number to select it. Once you select the device, 

detailed information for that device is displayed in the right pane of the interface.  
• Press the 'Program FPGA' button (Not the Program FX/2 button!) and select 

the MAYAPROv3000.xsvf file. 
• Programming begins immediately, and the estimated time for completion of the 

reprogramming process displays in the bottom status bar. DO NOT INTERRUPT the 
programming process for any reason!  If the programming process is interrupted, 
permanent corruption can occur in the device.  Programming the FX/2 will take about 
15 minutes. 

• Once the programming is complete, a pop up window will appear telling you to 
power down the spectrometer. Unplug the spectrometer from the computer. 

Configure the spectrometer’s startup baud rate 

• Connect the spectrometer to the computer using a serial cable. You might use the 
HR4000 Break-Out Box to make this connection. 
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• Power the spectrometer, e.g. by also connecting it to the computer via USB cable. 
• Using PuTTY or other serial console, connect to the spectrometer using these settings 

- Baud rate: 9600; Data bits: 8; Stop bits: 1; Flow control: None 
• Type 'aA' to set the spectrometer to ASCII mode 
• Type 'S' to confirm that the spectrometer is acquiring spectra. If everything is going 

right, you should receive 2048 spectral intensities, one from each pixel. 
• Type '?x18<ENTER>' to query the start up baud rate. The spectrometer should 

answer '2' indicating a baud rate of 9,600. 
• Type 'x18<ENTER>'. The spectrometer will wait for further input. Type '6<ENTER>'. 

This should change the start up baud rate to 115,200. 
• Check to make sure it worked by typing '?x18<ENTER>'. The spectrometer should 

now answer '6'. 
• Unplug the USB cable and close PuTTY. 
• Wait 10 seconds 
• Plug the USB cable back in.  
• Open PuTTY, but this time connect with 115,200 baud. 
• Again, type 'aA' followed by 'S'. You should now receive the spectrum much quicker 

than before. 

Connecting the Maya Pro to the NOVAC system 

• The Maya Pro needs to be connected to the serial port of the embedded PC. It also 
needs to be supplied with power from the Octopus electronics. Currently, the best 
way to accomplish this is by building a custom adapter that plugs into the 30-pin 
connector next to the Maya’s USB port. 

• One way to build this custom connector is by starting off with an Ocean Optics HR4-
CBL-DB15 adapter. This adapter can be ordered with the Maya Spectrometer. 

• Open the housing of the DB15 connector and remove the black heat shrink and any 
tape on this end of the adapter. 

• Identify the 5 pins required for the NOVAC adapter (see pin orientation diagram and 
connection table below) and solder these to the appropriate pins on the serial DB9 
and DC power barrel connectors. Use heat shrink to isolate the conductors. 

• Once the adapter has been built, plug the cable coming from serial port 1 of the 
embedded PC to the female DB9 connector. Plug the power cable coming from the 
Octopus into the female barrel connector. The Maya Pro should now receive power 
from the Octopus and be ready to communicate with the embedded PC. 

 

Figure 68 – The original Ocean Optics HR4-CBL-DB15 adapter cable can be ordered from Ocean Optics 
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Maya 30-pin connector Function NOVAC connectors 

Pin 1 RS232 Rx Female DB9 Pin 3 

Pin 2 RS232 Tx Female DB9 Pin 2 

Pin 5 Gnd Female DB9 Pin 5 

Pin 12 5V in Barrel connector inside contact 

Pin 29 Gnd Barrel connector outside contact 

Table 1 -Pin orientation and required connections for the custom NOVAC adapter cable 

 

 

Figure 69 – Adapter cable plugged into Maya Pro spectrometer after modification for use in a NOVAC 

system. The adapter now has a DB9 serial connector and a DC power socket. 

 

Update the embedded PC 

• At the time of this writing (March 2020), the Maya spectrometer has been 
successfully tested on the MOXA embedded PC with kongo software version 180617. 
If using a MOXA, it is recommended that a fresh install of this software be made. If 
using an Axiomtek embedded PC, the most current software version should be used, 
and the embedded PC may not have to be updated as per the instructions listed in 
the next few steps. 

• If needed, reset the embedded PC to factory settings (see instructions in this 
manual). 

• Using the file install180617.tar on MOXA, configure the embedded PC using the 
appropriate software version. See section 8.2. "Installation of NOVAC program 
(kongo) on a newly formatted MOXA computer".  
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• Remember to (re-)configure the CFG.txt and /etc/network/interfaces files after 
performing this update. 

Modifying the CFG.TXT file 

• The CFG.TXT is located on the embedded computer at /mnt/flash. Download the file 
to your computer. See section 3.2 "Configuring the instrument in the field" for 
detailed instructions. 

• Ensure the following parameters are set in the configuration: 
o SPECTROMETERTYPE=MAYAPRO 
o INSTRUMENTNAME=[SERIAL NUMBER] (use your spectrometer's serial 

number, e.g. MAYP111125) 
• Once the CFG.TXT has been modified, upload it back to the embedded PC, 

overwriting the original file. Restart the PC. 

 

Configuring the NOVAC Program 

• The proper configuration of the NOVAC instrument using the MayaPro spectrometer 
depends on the type of embedded PC (and version of kongo.exe) you are using. 

• If using a MOXA embedded PC and kongo.exe version 180617, then the NOVAC 
instrument will convert each acquired spectrum to a format compatible to an S2000 
spectrometer. To do this, the “Number of Spectra” parameter will be multiplied by an 
additional factor of 16. Thus, when the NOVAC Program receives a spectrum it will 
divide each spectrum by 16, lowering the maximum pixel intensity from 65,535 to 
4095. The spectra can then be handled as if they had been acquired by an S2000 or 
similar spectrometer. When using this setup, the NOVAC instrument therefore needs 
to be configured in the NOVAC Program as using an S2000 spectrometer, even 
though a Maya Pro is actually being used. 

• If, on the other hand, a newer Axiomtek embedded PC is being used along with a 
more current version of kongo.exe, then the NOVAC instrument should be configured 
as a Maya Pro spectrometer in the NOVAC Program. This newer version of the data 
acquisition software does not divide each spectrum by 16. Hence, the NOVAC 
Program can be configured to expect 65,535 counts as a maximum pixel intensity. 


